Vehicle-Mount Computer

User Guide

VC80
Revision History

Changes to the original guide are listed below:

<table>
<thead>
<tr>
<th>Change</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-01 Rev A</td>
<td>01/2016</td>
<td>Initial release.</td>
</tr>
<tr>
<td>-02 Rev A</td>
<td>12/2016</td>
<td>Add: WifiReconnectService; Kiosk application; Mounts Guides under Related Documents; Properties under TekWedge.</td>
</tr>
<tr>
<td>-03 Rev A</td>
<td>05/2017</td>
<td>Add VC80 Windows 10 configuration and software chapter.</td>
</tr>
<tr>
<td>-04 Rev A</td>
<td>04/2018</td>
<td>Update Table 5-1: Troubleshooting: updated cause &quot;The optional external speaker cable is connected without the speaker&quot; to match VC80x guide. Removed cause &quot;Power is not enabled on the COM port&quot; to match VC80x guide. Updated My-T-Soft section to clarify accessing Build-A-Board, added Build-A-Board screenshot.</td>
</tr>
<tr>
<td>-05 Rev A</td>
<td>06/2018</td>
<td>Corrected description for accessory power supply in Table 6-1 Accessories.</td>
</tr>
</tbody>
</table>
Chapter 2: Installation
Introduction ...................................................................................................................................... 2-1
Overview ......................................................................................................................................... 2-1
Mounting Instructions ....................................................................................................................... 2-1
Heater Status .................................................................................................................................... 2-1
Installing the VC80 .......................................................................................................................... 2-2
  Electrical Installation ...................................................................................................................... 2-2
    Wiring Guidelines ......................................................................................................................... 2-3
  Wiring Vehicle Power to the VC80 ................................................................................................. 2-4
  Positioning the VC80 in the Vehicle ............................................................................................... 2-5
  Overview of the Assembly Steps ................................................................................................... 2-5
  Cable Dust Cover .............................................................................................................................. 2-5
  Strain Relief ................................................................................................................................... 2-5
  Installing the VC80 on a Forklift ................................................................................................... 2-6
Forklift Battery Replacement Conditions ....................................................................................... 2-7
Starting from Cold Soak .................................................................................................................... 2-7
Installing the Power Pre-Regulator ............................................................................................... 2-8
Non-Vehicle Installations .................................................................................................................. 2-8
Power On/Off with Ignition ............................................................................................................. 2-9
Screen Blanking Wiring ..................................................................................................................... 2-10
  Connecting Switch for Screen Blanking ....................................................................................... 2-10

Chapter 3: Software Windows 7
Introduction ........................................................................................................................................ 3-1
Microsoft Windows Setup and Configuration .................................................................................. 3-1
  Folder Structure .............................................................................................................................. 3-1
VC80 Windows 7 Software Components ....................................................................................... 3-2
VC80 Windows 7 Without Operating System ................................................................................ 3-2
Connecting VC80 Windows 7 to Terminal Emulation .................................................................... 3-3
  TekTerm ......................................................................................................................................... 3-3
VC80 Windows 7 Bar Code Scanners and Settings ....................................................................... 3-4
  Serial Scanners for VC80 Windows 7 ........................................................................................... 3-4
  USB Scanners for VC80 Windows 7 ............................................................................................. 3-6
  Bluetooth Scanners for VC80 Windows 7 ................................................................................... 3-6
    Pairing Bluetooth Scanners Using Bar Codes for VC80 Windows 7 .......................................... 3-6
Settings for VC80 Windows 7 ........................................................................................................... 3-9
Quick Setup for VC80 Windows 7 .................................................................................................... 3-10
  Touch Panel Calibration for VC80 Windows 7 .............................................................................. 3-11
  Manage VC Configuration for VC80 Windows 7 ................................................................ ........ 3-16
Bezel Keyboard for VC80 Windows 7 ............................................................................................. 3-17
Haptic Feedback for VC80 Windows 7 ............................................................................................ 3-18
### Chapter 4: Software Windows 10

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power for VC80 Windows 7</td>
<td>3-20</td>
</tr>
<tr>
<td>Push To Talk for VC80 Windows 7</td>
<td>3-21</td>
</tr>
<tr>
<td>Screen Blanking for VC80 Windows 7</td>
<td>3-22</td>
</tr>
<tr>
<td>System Info for VC80 Windows 7</td>
<td>3-23</td>
</tr>
<tr>
<td>TekWedge for VC80 Windows 7</td>
<td>3-24</td>
</tr>
<tr>
<td>UPS Battery Status for VC80 Windows 7</td>
<td>3-27</td>
</tr>
<tr>
<td>Data Logging for VC80 Windows 7</td>
<td>3-28</td>
</tr>
<tr>
<td>My-T-Soft</td>
<td>3-29</td>
</tr>
<tr>
<td>GPS</td>
<td>3-31</td>
</tr>
<tr>
<td>Satellite Level</td>
<td>3-32</td>
</tr>
<tr>
<td>Location Coordinates</td>
<td>3-32</td>
</tr>
<tr>
<td>U-Center Software</td>
<td>3-32</td>
</tr>
<tr>
<td>Kiosk</td>
<td>3-33</td>
</tr>
<tr>
<td>Configuration and Activation of Kiosk Mode</td>
<td>3-33</td>
</tr>
<tr>
<td>Shell Settings</td>
<td>3-33</td>
</tr>
<tr>
<td>Security</td>
<td>3-34</td>
</tr>
<tr>
<td>Lockdown</td>
<td>3-34</td>
</tr>
<tr>
<td>Monitor Utility</td>
<td>3-34</td>
</tr>
<tr>
<td>Additional Software</td>
<td>3-35</td>
</tr>
<tr>
<td>Completing Setup</td>
<td>3-35</td>
</tr>
<tr>
<td>Exiting Kiosk Mode</td>
<td>3-35</td>
</tr>
<tr>
<td>Launching Applications without UAC Prompt</td>
<td>3-36</td>
</tr>
</tbody>
</table>

### Introduction

Microsoft Windows Setup and Configuration

VC80 Widows 10 Software Components

VC80 Windows 10 Without Operating System

Connecting VC80 Windows 10 to Terminal Emulation

TekTerm

VC80 Windows 10 Bar Code Scanners and Settings

Serial Scanners for VC80 Windows 10

USB Scanners for VC80 Windows 10

Bluetooth Scanners for VC80 Windows 10

Pairing Bluetooth Scanners Using Bar Codes for VC80 Windows 10

Settings for VC80 Windows 10

Quick Setup for VC80 Windows 10

Touch Panel Calibration for VC80 Windows 10

Manage VC Configuration for VC80 Windows 10

Accelerometer for VC80 Windows 10

Bezel Keyboard for VC80 Windows 10

Haptic Feedback for VC80 Windows 10

Heater Status for VC80 Windows 10

Power for VC80 Windows 10

Push To Talk for VC80 Windows 10

Screen Blanking for VC80 Windows 10
## Chapter 5: Maintenance and Troubleshooting

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>5-1</td>
</tr>
<tr>
<td>Cleaning</td>
<td>5-1</td>
</tr>
<tr>
<td>Housing Cleaning</td>
<td>5-1</td>
</tr>
<tr>
<td>Touchscreen Cleaning</td>
<td>5-1</td>
</tr>
<tr>
<td>Touchscreen</td>
<td>5-2</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>5-3</td>
</tr>
</tbody>
</table>

## Chapter 6: Accessories and Mounting

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>6-1</td>
</tr>
<tr>
<td>Accessories</td>
<td>6-1</td>
</tr>
<tr>
<td>External Bar Code Scanners</td>
<td>6-5</td>
</tr>
<tr>
<td>VC80 Antenna Options</td>
<td>6-6</td>
</tr>
<tr>
<td>VC80 Mounting Accessories</td>
<td>6-7</td>
</tr>
<tr>
<td>MT43XX RAM Mount</td>
<td>6-8</td>
</tr>
<tr>
<td>Optional Mounts</td>
<td>6-9</td>
</tr>
<tr>
<td>Plate Bases for MT35XX Mounts</td>
<td>6-9</td>
</tr>
<tr>
<td>MT4200 Quick Release Mount</td>
<td>6-10</td>
</tr>
<tr>
<td>Assembling MT4200</td>
<td>6-10</td>
</tr>
<tr>
<td>Attaching MT4200 to VC80</td>
<td>6-11</td>
</tr>
<tr>
<td>MT4210 Adaptor Bracket</td>
<td>6-12</td>
</tr>
</tbody>
</table>

## Chapter 7: Scancode Map

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>7-1</td>
</tr>
<tr>
<td>Integrated Keypad</td>
<td>7-2</td>
</tr>
</tbody>
</table>
Appendix A: Specifications

Introduction .................................................................................................................. A-1
Technical Specifications .................................................................................................. A-2
VC80 Drill Hole Dimensions .......................................................................................... A-5
ABOUT THIS GUIDE

Introduction

This guide provides instructions for setting up, operating, configuring, and maintaining the VC80 vehicle-mount computer.

✓ **NOTE** Screens and windows pictured in this guide are samples and can differ from actual screens.

⚠️ **WARNING!** Before transporting, assembling, and starting the computer, please read this manual carefully and follow all the safety guidelines and requirements.
Configurations

VC80 Windows 7 Configurations

The VC80 offers different configurations to suit various work requirements. Some of the configuration options include:

- Intel E3825 Dual Core, 1.33 GHz, 1 MB Cache, 2 GB RAM
- Intel E3845 Quad Core, 1.91 GHz, 2 MB Cache, 4 GB RAM
- SSD (32 GB or 64 GB)
- Sunlight Readable Display
- Internal Antenna
- External Antenna
- Freezer Condensing
- Windows Embedded Standard 7
- Windows 7 Professional for Embedded Systems
- Basic I/O
- CanBus
- Ethernet

Configurations for VC80 Windows 10

The VC80 offers different configurations to suit various work requirements. Some of the configuration options include:

- Intel E3845 Quad Core, 1.91 GHz, 2 MB Cache, 4 GB RAM
- SSD (64 GB)
- Sunlight Readable Display
- Internal Antenna
- External Antenna
- Freezer Condensing
- Windows Embedded Standard 7
- Windows 10 IoT Enterprise 2016 LTSB Entry
- Basic I/O
- CanBus
- Ethernet

NOTE For detailed configuration and part number information, contact your Zebra representative.
Chapter Descriptions

Topics covered in this guide are as follows:

- **Chapter 1, Getting Started**, provides information on safety guidelines and initial VC80 setup.
- **Chapter 2, Installation**, provides instructions on installing the VC80.
- **Chapter 3, Software Windows 7**, explains how to configure the VC80 with Windows 7.
- **Chapter 4, Software Windows 10**, explains how to configure the VC80 with Windows 10.
- **Chapter 5, Maintenance and Troubleshooting**, includes instructions on cleaning the VC80 and provides troubleshooting solutions for potential problems during device operations.
- **Chapter 6, Accessories and Mounting**, describes the accessories and mounting options available for the VC80.
- **Chapter 7, Scancode Map**, provides information on the integrated scancode maps for the VC80.
- **Appendix A, Specifications**, summarizes the device’s intended operating environment and technical specifications.

Notational Conventions

The following conventions are used in this document:

- **Italics** are used to highlight the following:
  - Chapters and sections in this guide
  - Related documents.
- **Bold** text is used to highlight the following:
  - Dialog box, window and screen names
  - Drop-down list and list box names
  - Check box and radio button names
  - Icons on a screen
  - Key names on a keypad
  - Button names on a screen.
- Bullets (•) indicate:
  - Action items
  - Lists of alternatives
  - Lists of required steps that are not necessarily sequential.
  - Sequential lists (e.g., those that describe step-by-step procedures) appear as numbered lists.
Related Documents and Software

The following document provides more information about the VC80 vehicle-mount computer.

- **U-Mount Bracket Installation Guide**, p/n MN-002931-xx - includes the instructions to install the U-Mount Bracket Kit (KT-U-MOUNT-VC80-R) and dimensions.
- **Adapter Bracket Kit for VC50 U-Mount Installation Guide**, p/n MN-002932-xx - provides instruction on installing the Adapter Bracket Kit (MNT-VC80-ADPA1-1) to attach the VC80 to the VC5090 U-Mount.
- **Adapter Bracket Kit for Honeywell U-Mount Installation Guide**, p/n MN-002934-xx - provides instruction on installing the Adapter Bracket Kit (MNT-VC80-ADPB1-1) to attach the VC80 to the Honeywell U-Mount Bracket.

For the latest version of this guide and all guides, go to: http://www.zebra.com/support.

Service Information

If you have a problem with your equipment, contact Zebra Customer Support for your region. Contact information is available at: [http://www.zebra.com/support](http://www.zebra.com/support).

When contacting support, please have the following information available:

- Serial number of the unit
- Model number or product name
- Software type and version number

Zebra responds to calls by email, telephone or fax within the time limits set forth in support agreements.

If your problem cannot be solved by Zebra Customer Support, you may need to return your equipment for servicing and will be given specific directions. Zebra is not responsible for any damages incurred during shipment if the approved shipping container is not used. Shipping the units improperly can possibly void the warranty.

If you purchased your Zebra business product from a Zebra business partner, contact that business partner for support.
Introduction

The VC80 is a rugged, vehicle mounted computer running Microsoft Windows Embedded Standard 7 and Windows Professional for Embedded Systems operating systems. Wireless communications are supported over a 802.11 WLAN network. The Bluetooth module supports Bluetooth printers and scanners. The VC80 can be used with or without an external keyboard. There are six programmable macro keys on the front bezel and when used with the Blue modifier key, provides six additional programmable keys.

The VC80 is intended for use in commercial and industrial applications with a focus on real time wireless data transactions with options suiting materials handling applications in warehouses, manufacturing facilities, ports, yards, and freezers.

Unpacking

**WARNING!** Before operating the unit for the first time, carefully read Safety on page 1-2.

**NOTE** Configure the computer before fastening it to machines or vehicles.

Carefully remove all protective material from the device and save the shipping container for later storage and shipping.

Inspect the equipment for damage. If any equipment is missing or damaged, contact the Zebra Support Center immediately. See Service Information on page xii for contact information.

Removing the Protective Film from the Display

The front display of the VC80 is protected during transport by a transparent film. This film should remain on the front display during assembly to avoid damage to the front display surface. Only remove the film once all of the assembly work has been completed.
Safety

In order to prevent injury and damage, observe the following safety guidelines *prior to assembly and commissioning*. The VC80 is a multifunction terminal for stationary and mobile use in commercial environments such as, warehouses, manufacturing, yard/ports, and freezers. Different or extraordinary usage is not permitted. For resulting damage, the user/operator of the VC80 is solely responsible. This also applies to any changes that you make to the device. Compliance with the safety guidelines is particularly important for the proper use of this device. The manufacturer assumes no liability for any and all damages that can be attributed to non-compliance with these guidelines.

**Initial Operation Safety Considerations**

- **Installation/Initial Operation** - Perform VC80 installation in accordance with *Chapter 2, Installation*. Specifically, pay special attention to the various electrical potentials of the vehicle. Some vehicles have a chassis that is connected to one of the battery supply lines (DC+ or DC-), while most electrically-driven forklift vehicles have floating chassis, connected to neither DC+ or DC-. See *Wiring Vehicle Power to the VC80 on page 2-4* for required wiring of vehicle power and fusing for the VC80.
- **Risk of injury during transit or installation** - The unit can fall during transit or installation and cause injury. Always ensure that there are two persons available when installing or removing the device.
- **Ensure that no persons are injured in case the mounting bracket breaks** - The VC80 may not be installed in such a way that persons can be injured during a breaking of the mounting bracket (e.g. fatigue break). If the device is mounted in a place where people can be injured if the bracket breaks, apply appropriate safety measures (e.g. install a security cable in addition to the device bracket).

**Power Supply/Cable Safety**

The main power cord shall comply with the national safety regulations of the country where the equipment is to be used.

- **Operation in an emergency** - In case of an emergency (such as damage to the power cable or housing, or ingress of liquid or other foreign bodies), disconnect the device immediately from the power supply. Contact technical support staff at once.
- **Protection of the power supplies** - If, after replacement, the fuse fed by the internal power supply blows, send the device for servicing immediately.
- **Danger of electrocution when cleaning/servicing the device** - In order to avoid electrocution, always disconnect the VC80 from the power supply before cleaning or servicing the device.
- **Do not exceed maximum voltage when charging the vehicle battery** - While charging the vehicle battery, disconnect the VC80 from the battery or ensure that the maximum allowed input voltage of the VC80 is not exceeded.
- **Do not switch on devices with damaged cables or plugs** - Do not use the VC80 if a cable or plug is damaged. Replace damage parts immediately.
- **Do not connect or disconnect cables during storms** - Cables must never be connected or disconnected during an electrical storm.

**External Devices Safety**

The use of additional wiring and other peripheral devices, which are not recommended or sold by the manufacturer, can result in fire, electrocution or personal injury.

- If a power supply is used, only use the power supply recommended by the manufacturer.
- Before connecting or disconnecting peripheral devices (exception: USB devices), disconnect the VC80 from the power supply to avoid serious damage to both the VC80 and the connected devices.
VC80 Vehicle-Mount Computer Features

Figure 1-1  VC80 Front View

Figure 1-2  VC80 Top View

NOTE  Antenna options are dependent on the VC80 configuration. Some configurations only have internal antennas while other configurations have two or more external antenna connectors. WiFi antennas are not shipped with the VC80 and must be ordered as a separate accessory.
Figure 1-3  VC80 Back View with Dust Cover

Figure 1-4  VC80 Back View without Dust Cover
Front Keys and LED Indicators

The VC80 has the following front bezel keys and LEDs:

Front Keys

<table>
<thead>
<tr>
<th>Front</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power Keys</strong></td>
<td></td>
</tr>
<tr>
<td>On/Off Button</td>
<td>Powers the VC80 On or Off. To reset the device, press and hold the On/Off button for at least seven seconds until the green LED changes to amber.</td>
</tr>
<tr>
<td>Speaker/Display</td>
<td>Speaker volume and display brightness adjustment button. Use the (-) sign to decrease volume/brightness and use the (+) to increase the volume/brightness.</td>
</tr>
<tr>
<td>Keyboard</td>
<td>Display on screen keyboard.</td>
</tr>
<tr>
<td>Blue Modifier Key</td>
<td>Modifies programmable macro keys allowing for an additional six programmable keys. Press the Blue Modifier key twice to lock the key on and to unlock, press the key once again.</td>
</tr>
<tr>
<td>Macro Keys</td>
<td></td>
</tr>
<tr>
<td>Programmable</td>
<td>Six programmable macro keys. When used with the Blue modifier key, six additional programmable keys are provided. Keys may be mapped in the Control Panel by assigning scancodes (see Chapter 7, Scancode Map) or macro mapping with My-T-Soft.</td>
</tr>
</tbody>
</table>

Bar Codes

<table>
<thead>
<tr>
<th>Front</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pairing Bar Code</td>
<td>Pair peripheral Bluetooth scanners to the VC80.</td>
</tr>
<tr>
<td>Unpairing Bar Code</td>
<td>Unpair peripheral Bluetooth scanners to the VC80.</td>
</tr>
</tbody>
</table>

Speaker

| Front Speaker    | Located on front bezel.                                                |
LED Indicators

**Table 1-2  VC80 LED Indicators**

<table>
<thead>
<tr>
<th>Green/Amber LED</th>
<th>Red LED</th>
<th>Blue LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Off</td>
<td>Off</td>
<td>No external power and the VC80 is not running on UPS.</td>
</tr>
<tr>
<td>Amber On</td>
<td>Off</td>
<td>Off</td>
<td>External power is available but the VC80 is not turned On (in shutdown or hibernate mode). The VC80 is ready to be turned on and is currently charging the UPS battery.</td>
</tr>
<tr>
<td>Green On</td>
<td>Off</td>
<td></td>
<td>External power is available and the VC80 is turned ON. The UPS battery is charging.</td>
</tr>
<tr>
<td>Green Flashing (50% Duty Cycle On at 500ms Period)</td>
<td>Off</td>
<td></td>
<td>External power is removed. The VC80 is running on UPS battery power.</td>
</tr>
<tr>
<td>Green Flashing (25% Duty Cycle On at 4000ms Period)</td>
<td>Off</td>
<td>Off</td>
<td>The VC80 is in sleep mode.</td>
</tr>
<tr>
<td>Green On</td>
<td>Off</td>
<td>Off</td>
<td>Bezel keyboard keys: M1, M2, M3, M4, M5, M6</td>
</tr>
<tr>
<td>Green On</td>
<td>Off</td>
<td>On</td>
<td>Bezel keyboard keys: M7, M8, M9, M10, M11, M12</td>
</tr>
<tr>
<td>Off</td>
<td>Flashing Red (50% Duty Cycle On at 500ms Period)</td>
<td></td>
<td>Temperature related warning or error event in the system. Average of radio card and audio codec temperature readings is either &lt;-35° C or &gt; +65° C. No action is required if the OS is running. If the OS is in Sleep or Hibernate state, then the EC should switch the VC80 Off.</td>
</tr>
<tr>
<td>Off</td>
<td>On</td>
<td>Off</td>
<td>Warm up condition. The average of radio card and audio codec temperature readings is between -35° C and 0° C. The OS is not running. The Power Button is disabled.</td>
</tr>
</tbody>
</table>

**NOTE** For fields in the above table without LED information, the LED can be On or Off dependent on user actions and ambient temperature.

**Configuring GPS**

For VC80 configurations with GPS, see GPS on page 3-31 for information on setting up and configuring the GPS with U-Center.
Connecting External Devices

Disconnect the VC80 from the power supply before:

- Connecting or disconnecting external devices (e.g., scanner, keyboard).
- Connected to network.

⚠️ **CAUTION**  Turn on external peripheral devices with power supplies at the same time or after turning on the VC80. Ensure that the VC80 is adequately protected from power leakage caused by an external device.

Powering Up the VC80

Power up the VC80 after connecting all of the devices.

To power up the VC80, connect to an appropriate power supply and press the Power button (see Figure 1-1) or the ignition signal.

⚠️ **CAUTION**  Make sure there is a suitable disconnecting device such as a power switch or circuit breaker in the power supply circuit. See Installing the VC80 on page 2-2 for more information.

Powering Down the VC80

Always shut down the VC80 as follows:

1.  Select Start.
2.  Select Shut Down.
Setting Up WLAN

Connecting WLAN on VC80 with Windows 7

To connect to the WLAN:

1. Click on the **WiFi** icon in the system tray to display available WLAN networks.
2. Click on the desired network and select **Connect**.

![WLAN Connection on VC80 with Win 7](image)

Figure 1-5  WLAN Connection on VC80 with Win 7
Setting Up a New Connection or Network for VC80 with Win 7

To set up a new connection or network:

1. Click on the **WiFi** icon in the system tray.
2. Select **Open Network and Sharing Center** (see *Figure 1-5*).
3. Select **Set Up a New Connection or Network**.

![Network and Sharing Center](image)

*Figure 1-6  Setup New Connection or Network for VC80 with Windows 7*

4. Choose a connection option.
5. Follow the prompts to complete setup.
Broadcom Help for Window 7

The Broadcom Help utility assists with managing the WiFi connection or network.

To access Broadcom Help:

1. Go to Start > Control Panel > Broadcom Utility.
2. Select the Help tab on the top tool bar.
3. Select the desired topics for assistance.

Figure 1-7  Broadcom Help
Connecting WLAN on VC80 with Windows 10

To connect to the WLAN:

1. Left click on the WiFi icon in the system tray to display available WLAN networks.
2. Select the desired network and enter additional settings.

To manually connect to the WLAN:

1. Right click on the WiFi icon for networks that do not broadcast the SSID.

Figure 1-8  WLAN Connection on VC80 with Windows 10
Setting Up a New Connection or Network for VC80 with Windows 10

To set up a new connection or network:

1. Right click on the WiFi icon in the system tray.
2. Select Open Network and Sharing Center (see Figure 1-9).
3. Select Set Up a New Connection or Network.
4. Select Manually connect to a wireless network.

Figure 1-9  Open Network and Sharing Center for VC80 with Windows 10

Figure 1-10  Setup New Connection or Network for VC80 with Windows 10

Figure 1-11  Manually Connect to a Wireless Network
5. Enter wireless network information.

![Manually connect to a wireless network]

Enter information for the wireless network you want to add

- Network name: **MySSID**
- Security type: **WPA2-Personal**
- Encryption type: **AES**
- Security Key: **1234567890**

- [ ] Start this connection automatically
- [ ] Connect even if the network is not broadcasting
  Warning: If you select this option, your computer’s privacy might be at risk.

Figure 1-12  *Enter Wireless Network Information*

6. Select **Next**.

**Broadcom Help for Window 10**

The Broadcom Help utility is not available for Windows 10.
WiFiReconnectService

The WiFiReconnectService is a lightweight Windows Service that is designed to run in the background on any VC80 (Windows 7) device. It is included in the VC Control Panel installer. The service continuously monitors the WiFi connection state. It attempts reconnection to the last known good SSID in the event of a disconnect, or scans and reconnects to any saved network with a reasonable signal strength. The software is used to counteract slow default reconnect performance through the native WiFi stack.

By default, the WiFiReconnectService is set to Startup Type Manual (does not launch at startup). To activate the service, go to the Services control panel, edit the Service Properties to specify Automatic Startup, and Start the service.

Configuration

The WiFiReconnectService exposes a limited amount of timing parameters that can be modified to further optimize the VC80 reconnect time. All parameters are stored in the following registry key:

[HKEY_LOCAL_MACHINE\SOFTWARE\Zebra Technologies\Wifi Reconnect Service]

✓  **NOTE**  The registry configuration is read and applied whenever the WiFiReconnectService service starts. For parameter changes to take effect, a restart of the service is required.

The timing parameters are as follows:

- **BackoffTime** - Determines the number of seconds to back off (do nothing) following a disconnect event. The default is 0 and the range is 0 - 60s.

- **ConnectDuration** - Determines the number of seconds to attempt to reconnect to the last known good SSID following a disconnect. The default is 9999 and the range is 0 - 9999s. If quick roaming between multiple SSIDs is required, set this value to 0 so that disconnection immediately activates scan mode.

- **ConnectInterval** - Determines the number of seconds between individual reconnect attempts during the ConnectDuration period. The default is 5 and the range is 3 - 300s (5 minutes).

- **MinimumRssiNegative** - Provides the minimum RSSI for an existing connection to be considered good. When a connection has a lower RSSI, the service treats it as disconnected. Registry entries are positive numbers and the setting is negated to get the actual RSSI. For example, setting this registry entry to 80 means that the minimum RSSI is -80. If unset, any RSSI is considered fine. The default is Unset and the range is Unset, or -100 to -20.

- **MinimumSignalQuality** - Provides a minimum signal quality for an available network to be considered good. When in scanning mode, any available network with a signal quality lower than this value will be ignored. This is a percent. The default is 60 and the range is 1 - 100%.

- **PollingInterval** - Determines the interval for the main application loop, in milliseconds, to run and update the current connection status. A lower interval will result in better responsiveness, but will increase the CPU load. The default is 5000 and the range is 100 - 300000ms (5 minutes).

- **ScanInterval** - After the ConnectDuration value is reached, the software switches to scan mode and periodically launches a scan for available connections. When a connection is available for a saved profile that meets the minimum signal quality criteria, a connection to it is attempted. This parameter specifies the time interval between individual scans in seconds. A scan should take at most four seconds, according to Microsoft specifications. Performing frequent scans can affect the performance of the device. The default is 8 and the range is 4 - 300s.

- **VerboseMode** - When set to 1, this parameter enables verbose logging to the Event Viewer (Windows > Application section, source WifiReconnectService). The default is 0.
Event Viewer

By default, some logging regarding the starting/stopping of service is routed to the Event Viewer (*Windows > Application* section, source *WifiReconnectService*). To verify the configuration of the WifiReconnectService, filter the *WifiReconnectService* source, and verify the parameters used.

<table>
<thead>
<tr>
<th>General</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Running a new ReconnectManager with params (5000.0, 9999.5, 0, False, 60)</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 1-13  Event Viewer**

The parameters between the parenthesis correspond to the following:

(PollingInterval, BackoffTime, ConnectDuration, ConnectInterval, ScanInterval, VerboseMode, MinimumRssiNegative, MinimumSignalQuality)

Starting/Stopping Service

To halt the *WifiReconnectService* functionality, manually stop the service from the Services or Computer Management control panel. It may be restarted at any time.

**Figure 1-14  Start/Stop WifiReconnectService**
CHAPTER 2  INSTALLATION

Introduction

This chapter provides instructions on installing the VC80.

Overview

The VC80 can be installed in a variety of ways:

- Position the VC80 horizontally on a desk or mounted on a vehicle console.
- Wall mount the VC80 using the optional wall mount (see VC80 Mounting Accessories on page 6-7).
- Overhead mount on a lift truck cage using mounting hardware.

Depending on the vibration resistance and pivoting demands, mounting brackets, clamp feet or RAM mount elements can also be used to attach the device. Contact your Zebra sales office to find out more about the range of available installation options.

WARNING! The unit could fall during transit or installation/mounting and cause injury. Always ensure that there are two people available when installing or removing the device.

Mounting Instructions

Follow and retain the mounting instructions included with assembly kit when installing the VC80. See Safety on page 1-2 for safety instructions.

Heater Status

The VC80 offers a unique heater system that enables continuous operations in freezer environments. See Heater Status for VC80 Windows 7 on page 3-19 for information about the heater settings.
Installing the VC80

Electrical Installation

There are various electrical potentials when installing the unit on a vehicle such as a forklift.

![Ground Lug]

**CAUTION** Most electrically driven forklift vehicles have floating chassis connected to neither DC+ or DC-. However, electrical faults can cause the battery + or - to be connected to the chassis via low resistance paths. All connected peripherals must be completely isolated.

The VC80 accepts DC power sources with a minimum of 10VDC nominal and 48VDC nominal. A Power Pre-regulator is required for voltages above 48VDC nominal.

Applying a voltage above 48VDC nominal without the pre-regulator or reversing polarity may result in permanent damage to the VC80 and voids the product warranty.

![VC80 Ground Lug]

**CAUTION** Attach the VC80 connecting cable as close to the battery as possible. Connecting the VC80 to large electrical loads, such as converters for the forklift motor may result in random restarts, malfunctions and/or irreparable damage to the device.

To connect devices fed by other power sources to the VC80, such as printers, power up the peripheral devices at the same time or after the VC80 to avoid start-up problems, malfunctions or irreparable damage to the device.
Wiring Guidelines

The metal chassis of the VC80 is equipped with a ground lug (located on the underside adjacent to the power cable) to provide additional ground to the vehicle. It is strongly recommended that a grounding strap is used to connect the ground stud on the vehicle-mount to a solid, reliable contact point on the main portion of the vehicle chassis. It must not be connected to battery negative or terminal block.

As with other vehicle cables, carefully consider the routing of the ground strap to ensure it does not pose a hazard to the operator or the safe operation of the vehicle. If necessary, secure the ground strap with cable ties or some other mechanical means to prevent loops or loose lengths of wire from catching on stationary items when the vehicle is in motion.

Before installing the cables between the mount and other devices, consider the following:

- Ensure that drilling holes do not damage the vehicle or its wiring.
- Protect cable runs from pinching, overheating and physical damage.
- Use grommets to protect cables that pass through metal.
- Use plastic straps and tie-downs to secure cables and connectors in their desired location, away from areas where they may get snagged or pulled.
- Keep cables away from heat sources, grease, battery acid and other potential hazards.
- Keep cables away from control pedals and other moving parts that may damage the cables or interfere with the operation of the vehicle.

**IMPORTANT** Make sure the cables run inside the roll cage of the vehicle.

If the VC80 is installed in an environment where earth ground is present such as a vehicle with metal wheels running on a metal track, or is powered by the AC/DC adaptor in a permanent installation, the ground lug must be connected to the ground structure.
Wiring Vehicle Power to the VC80

**WARNING** Applying voltage above the input voltage rating or reversing polarity may result in permanent damage to the VC80 and void the product warranty.

An extension power cable is used to wire the VC80 to the truck battery (order cable separately, see *Accessories on page 6-1*). Wire this cable to a filtered, fused (15A max) accessory supply on the vehicle. Follow the installation instructions supplied with the extension cable.

Additional wiring (minimum 14 gauge), connectors or disconnects used should be rated for at least 300 VDC, 15A.

When connecting the extension power cable:

- If a power extension cable with ignition sense is used, ensure that the ignition sense wires (18AWG wires in red and black leads) and the power wires (14AWG in red and black leads) are reliably secured away from each other, or are separated with reliably secured certified insulation. Minimum 2.8 mm distance, or 0.4mm distance through insulation is required for the separation.

- The red lead of the 14AWG power cables attach to the vehicle’s battery positive terminal. The 14AWG black lead connects to the vehicle’s battery negative terminal. This should be connected to a proper terminal block and not to the vehicle body. An optional grounding strap wire (sourced separately) may be connected to the ground lug of the VC80 terminal connector bay and to the vehicle chassis.

- You may have the option to connect power before or after the key switch. Though the VC80 is equipped with a UPS, a proper shut down is recommended using the windows shut down procedure. If it is wired after the key switch, the operator must shut down the VC80 using the Windows shut down procedure before turning off the vehicle. If it is wired before the key switch, then to avoid excessive drain on the vehicle battery, either the operator should shut it down when the vehicle is to be left off for an extended period, or the ignition cable shut down wire should be connected and the VC80 configured to shut down automatically.

- An appropriate fuse type must be used with the power extension cable according to the installation instructions. For main power cable, use 3AB, 15A, 250V, slow blow fuse. For ignition sense input, use 3AB, 0.3A, 250V, slow blow fuse.

**NOTE** The VC80 supports the ignition sense feature that detects when the ignition switch or key switch is On or Off to allow automatic computer start up or shut down (with delay as needed).

When wiring the ignition sense wires (18AWG in red and black), the red 18AWG wire is connected to a positive DC voltage source switched on by the ignition. The black 18AWG wire is connected to ground reference of this switched ignition source.
Positioning the VC80 in the Vehicle

When positioning the VC80 on the vehicle:

- The driver's field of view must be kept free.
- Plan for sufficient space if a keyboard and scanner are installed with the VC80.
- No part of the VC80 system may project beyond the vehicle.

Overview of the Assembly Steps

Before fastening the VC80 to the vehicle:

- Configure shut down automation.
- Prepare the forklift such as ignition connection and correct voltage.
- It is recommended to fasten the bracket to the vehicle and then install the VC80 to the bracket.

Cable Dust Cover

For the dust cover location, see VC80 Back View with Dust Cover on page 1-4.

CAUTION  Turn on external peripheral devices with their own power supply at the same time or after the VC80. If this is not possible, ensure that the VC80 is adequately protected from power leakage caused by an external device.

CAUTION  For safety reasons, install the supplied cable cover for the external ports prior to using the VC80.

Strain Relief

After the VC80 and bracket are fastened, prepare the strain relief as follows:

1. Install the cables loosely on the strain relief rail (see Figure 1-4 on page 1-4).
2. As far as possible, route cables leading to or away from the unit next to one another without crossing.
3. Fasten the cables into the strain relief rail precisely at the positions at which the cable openings in the cable cover are located.
Installing the VC80 on a Forklift

⚠️ **CAUTION** Tighten peripherals with thumbscrews by hand only. Do not use tools for tightening thumbscrews.

✔️ **NOTE** If installing peripherals, allow enough space when selecting a mounting location.

1. Attach the desired mount to the VC80. Refer to the VC80 User Guide at www.zebra.com/support for detailed mounting options and instructions.
2. Attach the mounted VC80 to the vehicle and position in a location that does not obstruct the operator’s view.
3. If using an external antenna, connect antenna in a vertical position to the VC80.
4. Connect peripherals to the VC80. Place the cables in the strain relief brackets inside the dust cover and replace the dust cover (see *Figure 1-3 on page 1-4*).
5. Connect the VC80 to the vehicle DC supply.
6. Press the **Power** button to turn the device On or Off (see *Figure 1-1 on page 1-3*).

---

View Obstruction Considerations

![Diagram showing view obstruction considerations on a forklift](image)

*Figure 2-2  View Obstruction Considerations*
Forklift Battery Replacement Conditions

The VC80 maintains normal function of applications and connections during and after forklift battery replacement.

Replace the forklift battery at any point during a shift and/or while the VC80 is fully running.

The forklift battery may be replaced under following condition: VMC external temperature range: -30° C to +50° C.

During forklift battery replacement (VMC is running on UPS battery), both Windows and the VC80 are monitoring remaining UPS battery capacity. The default Low Battery notification threshold is set to 20% for all Windows Power plans. The Critical Battery threshold is set to 10%. If UPS battery is discharged below 10%, the VC80 automatically shuts down.

An additional notification message can be enabled in the VC80 with a threshold set to the configured Low Battery level plus an additional 10%. If enabled, this message appears to the User when the UPS battery is discharged to 30% (20% + 10%) level.

Starting from Cold Soak

The VC80 does not startup from a saturated cold soak when internal VC80 temperature (critical components and UPS battery) is below -30° C or UPS battery has less than 10% capacity. The red LED warning indicator may display.

The VC80 can to start up from a saturated cold soak at -30° C (or above) internal VC80 temperature when a valid external DC power source is present.

The VC80 design minimizes wait time from -30° C cold soak to load the OS and have internal heaters to assist system warm up.

From a -30° C cold soak condition, the VC80 battery heater may be activated to warm the UPS battery to an acceptable charging temperature if charging is needed. The conditions and time to heat the battery are managed by the system. The OS load time and VC80 ready for use time is independent of warming the battery.
Installing the Power Pre-Regulator

**IMPORTANT** The Zebra power extension cable positive lead is red and the negative lead is black.

It is recommended that all connections be secured with electrical tape or heat shrink to prevent contaminants from degrading the connection.

To install the power pre-regulator:

1. Attach the pre-regulator cable male connector to the Zebra power extension cable which is installed on the vehicle.
2. Connect the pre-regulator cable female connector either directly to the VC80 power cable, or to the power extension cable. See Figure 2-3.

**Without Power Pre-regulator**  
For vehicles with DC power 48V or less

**With Power Pre-regulator**  
For vehicles with DC power greater than 48V

---

**Non-Vehicle Installations**

Using AC power, the VC80 Vehicle-Mount Computer can be mounted at fixed locations adjacent to cross-dock doors, manufacturing stations, or in offices.

Use the 100/240 VAC Power Supply (p/n PS000145A01) to power the computer from an AC source.

**IMPORTANT** The AC/DC power supply is only intended for use at room temperature condition such as an office environment.
Power On/Off with Ignition

The VC80 is equipped with an ignition sense feature which puts the terminal into suspend/shutdown when the vehicle ignition is turned off and can power on the terminal when the ignition is switched on. To use this feature, a power extension cable with ignition sense wires must be used and installed properly on the vehicle.

The cable in Figure 2-4 is the power extension cable (p/n CA1220) with two wires used to connect to vehicle ignition. The red and black leads of the two 18AWG wires that connect to the key switch of the ignition and ground, respectively. Once the wires are connected, the VC80 may switch on or off depending on the state of the vehicle ignition key. See Power for VC80 Windows 7 on page 3-20 to select power settings.

**IMPORTANT** When connecting to an ignition switch using the power extension cable with ignition sense wires, ensure that the wires of different polarities are reliably secured away from each other, or are separated with reliably secured certified insulation. A minimum distance of 2.8mm (or 0.4mm distance through insulation) is required for the separation.

The thinner wires (18 AWG) are used for Ignition Sense wires while the thicker wires (14AWG) are used for Vehicle Power and Ground. Identify them carefully and **Do Not** confuse them.

An appropriate fuse type must be used with the power extension cable according to the installation instructions. For the main power cable, use 3AB, 15A, 250V, slow blow fuse. For ignition sense input, use 3AB, 0.3A, 250V, slow blow fuse.

![Figure 2-4 Power Extension Cable Kit with Optional Ignition Sense Wires (p/n CA1220)]
Screen Blanking Wiring

Connecting Switch for Screen Blanking

To use Screen Blanking, connect one of the two DB9 serial ports (using CA1300 Screen Blanking cable) on the VC80 to a switch. Activate this switch electrically (e.g. motion sensor, GPS) or mechanically (e.g. pedal switch) when the vehicle is in motion.

Figure 2-5  Connecting the Switch to the DB9 Cable

**IMPORTANT** For customers migrating to the VC80 from a 8515, 8525, 8535 vehicle mount computer or a 753x hand-held computer cradle:

If the screen blanking feature was used previously, ensure that you are no longer feeding the screen blanking signals to the VC80 main DC power cable. Rewire the screen blanking inputs to the VC80 DB-9 serial port through the DB-9 screen blanking cable. In previous generations of vehicle-mount computers, the screen blanking signals were fed in to the terminal through 2 of the 4 wires in the CPC connector of the DC power cable. This no longer applies for the VC80.

The screen blanking feature makes use of either one of the DB-9 ports to monitor electrical relay closure. When enabled, the CTS/RTS pins of the DB9 port are continuously monitored by the screen blanking application. See Figure 2-6 for pin configuration.

When the vehicle is in motion, the switch closes the circuit, allowing data packets to be sent or received through the RTS and CTS pins. The computer detects that the circuit is closed and turns off the screen.

When the vehicle is not in motion, the switch opens the circuit, preventing data packets from being sent or received. The computer detects that the circuit is open and turns on the screen.

Figure 2-6  Screen Blanking DB9 Pin Configuration
CHAPTER 3 SOFTWARE WINDOWS 7

Introduction

This chapter provides software information and instruction for the VC80 with Window 7.

Microsoft Windows Setup and Configuration

After the system files are processed, Microsoft Windows loads. Standard Windows configuration options apply to the VC80. Configuration options are located in the System Tray or the Control Panel. For example, use the System Tray to adjust the time, date or volume level and the Control Panel to add, delete or modify software.

Folder Structure

Microsoft Windows is installed in the \Windows folder. For information on the folder structure, refer to the commercially available Microsoft Windows OS Reference Guide.
VC80 Windows 7 Software Components

The VC80 contains the following software components:

• BIOS
• Embedded Controller firmware
• Microsoft Operating System (Windows 7 Standard or Professional).
• VC Control Panel

The following Windows OS features are unique to the VC80 (dependent on configuration):

• Touch driver
• WLAN/Bluetooth driver
• Ethernet driver
• GPS
• Zebra printer tools and drivers.

The Embedded Controller manages communication with the following VC80 unique features:

• Heaters
• Battery state
• Data logging.

VC80 Windows 7 Without Operating System

The VC80 can be ordered with no operating system. This configuration requires the following:

• Windows 7 installation media
• A valid product licensing key.

When prompted for driver locations during installation and setup, direct the device wizard to the USB drive.

• For Windows 7 drivers, go to: www.zebra.com/support.
Connecting VC80 Windows 7 to Terminal Emulation

The VC80 supports terminal emulators such as TekTerm. For connection to a host, have the following information available:

- Alias name or IP host address
- Port number of the host system
- Emulation.

To connect to a host:

1. Ensure the mobile client network settings are correctly configured.
2. Ensure the VC80 is connected to the network if connecting via WLAN.
3. Launch the terminal emulation application.

TekTerm

TekTerm is a powerful terminal emulation software application with the ability to interface with multiple Bluetooth and serial scanners. TekTerm is pre-licensed and pre-installed on the VC80.

It is recommended to check the latest TekTerm version released for the VC80. For more information regarding TekTerm, go to: www.zebra.com/support.
VC80 Windows 7 Bar Code Scanners and Settings

The VC80 supports the following types of bar code scanners:

- Tethered scanner connected to COM1 or COM2.
- Tethered scanner connected to a USB host port
- Wireless scanner connected via Bluetooth.

Serial Scanners for VC80 Windows 7

To configure serial scanners:

1. Open the VC Control Panel and select Power.
2. Enable the power to the port.

![Figure 3-1](image)  
*Enable Power for Serial Scanners (VC80 with Windows 7)*
3. Select TekWedge and select Enable TekWedge to support serial scanners.

4. Under Properties, make the following selections:
   - Enable Good Scan Beep - When enabled, a beep sounds upon a successful decode. When disabled, a beep does not sound upon a successful decode.
   - Ignore Caps Lock and Shift - When enabled, the state of Caps Lock and Shift keys do not affect the data received from the scanner. When disabled, the scanner data may be converted to upper/lower case based on the current state of the Caps Lock and Shift Keys.

5. Select Config Ports.

![Figure 3-2 Enable TekWedge for Serial Scanners](image)

6. Select the new COM port and select Enable Port.

![Figure 3-3 Enable Port for Serial Scanner (VC80 with Windows 7)](image)

7. Select OK.
USB Scanners for VC80 Windows 7

The Windows OS loads a USB driver for USB scanners. USB scanners are not controlled or managed by TekWedge therefore, post processing such as translation rules can not be used with USB scanners. 123Scan2 can be used to create rules and download to the scanner.

To configure USB scanners, connect the scanner to the VC80 USB port and follow the scanner setup instructions. For Zebra scanner guides, go to: www.zebra.com/support.

Bluetooth Scanners for VC80 Windows 7

See Quick Setup for VC80 Windows 7 on page 3-10 for information on connecting Bluetooth scanners. Always use TekWedge for VC80 Windows 7 on page 3-24 to configure Bluetooth parameters.

Pairing Bluetooth Scanners Using Bar Codes for VC80 Windows 7

√  NOTE  If the Bluetooth scanner connection to the VC80 is lost, it is recommended to first scan the Unpair bar code and then scan the Pair bar code.

To pair Bluetooth scanners using bar codes:

1. Select Bluetooth > Open Settings to access Bluetooth settings.

Figure 3-4  Open Settings (VC80 with Windows 7)
2. In the **Options** tab, select check boxes under **Discovery** and **Connections**.

![Bluetooth Discovery and Connections (VC80 with Windows 7)](image)

**Figure 3-5**  *Bluetooth Discovery and Connections (VC80 with Windows 7)*

3. In the **COM Ports** tab, select **Add**.

4. Select the radio button **Incoming (device initiates the connection)**.

5. Select **OK**.

![Add Incoming Bluetooth Devices (VC80 with Windows 7)](image)

**Figure 3-6**  *Add Incoming Bluetooth Devices (VC80 with Windows 7)*
6. Open the VC Control Panel and select **TekWedge**.

7. Enable **TekWedge**.

8. Select **Config Ports**.

![Enable TekWedge (VC80 with Windows 7)](image)

**Figure 3-7**  *Enable TekWedge (VC80 with Windows 7)*

9. Select the new COM port and select **Enable Port**.

![Enable COM Port for Bluetooth Device (VC80 with Windows 7)](image)

**Figure 3-8**  *Enable COM Port for Bluetooth Device (VC80 with Windows 7)*

10. Select **OK**.

11. Scan the bar code to pair the scanner (the scanner must be configured for SPP mode).
Settings for VC80 Windows 7

Select Start Menu > Admin Tools > VC Control Panel to configure the following VC80 settings:

- Quick Setup
- Bezel Keypad
- Haptics Feedback
- Heater Status
- Power
- Push to Talk
- Screen Blanking
- System Info
- TekWedge
- UPS Battery
- Data Logging

![VC Control Panel]

Figure 3-9 VC80 Settings (VC80 with Windows 7)
Quick Setup for VC80 Windows 7

Select Start Menu > VC Control Panel > Quick Setup to configure the following quick setup options.

Links to Microsoft or third party utilities:

- **Touch Panel Calibration** - Calibrate the touch panel.
- **WLAN Configuration** - Configure WLAN.
- **Network Configuration** - Configure network parameters such as, Static IP address and DHCP.
- **On-Screen Keyboard Configuration** - My-T-Soft Keyboard configuration.

VC80 control panel:

- **Manage VC Configuration** - Load or save configuration files.

![Quick Setup Settings (VC80 with Windows 7)](image)

Figure 3-10  Quick Setup Settings (VC80 with Windows 7)
Touch Panel Calibration for VC80 Windows 7

**Hardware**

Associates the pointer device with the monitor/desktop area that is controlled by the device and shows the hardware port information.

*NOTE* Select Help for detailed information on the Touch Panel Calibration options.

- **Handling Whole Desktop** - Whole indicates the primary monitor.
- **Connected to USB Port** - Displays the port connected to the device.
- **Add a New Device** - Option to add a device. Only non USB devices are manually added. USB devices are automatically added.
- **Remove this Device** - Option to remove a device. Only non USB or inactive USB are manually removed.

![Hardware Settings (VC80 with Windows 7)](image)

**Figure 3-11** Hardware Settings (VC80 with Windows 7)
Click Mode

- **Interactive Touch** - Shows the current click mode emulation for a single touch. The setting is only active if the driver is responsible for the pointer handling via the standard mouse interface into the OS.
- **Extended Touch** - Vista and above, UPDD can deliver touch co-ordinate data to the Windows OS via three interfaces: mouse class, HID class, Win8TI API interface.
- **Visual Notification** - Indicates if visual feedback is shown during Interactive Touch right click countdown.
- **Interactive Switch Delay** - Select the delay pace.
- **Sound Options** - Configure touch sound options.
- **System Mouse Settings** - Adjust the mouse pointer settings defined within the OS.
- **Test Icons** - Test Right Click and Double Click. A tick is shown if the click test is successful.

![UPDD Console](image)

**Figure 3-12**  Click Mode Settings (VC80 with Windows 7)
Properties

- **Name** - Associates a name to the device. By default the name is the drivers controller device name.
- **Low Pass Filter** - Applies a filter to produce a smoother drawing. The speed of drawing is affected, the higher the value used.
- **Liftoff Time** - Specifies the time interval required to register a stylus lift after the last touch packet is received. Lift off time is defined in units of 10ms.
- **Stabilization** - Causes small movements to be ignored.
- **Averaging** - Applies a filter to produce smoother drawings. Filtering can improve drawing without affecting the drawing speed.
- **Mode** - In a multi pointer device environment, this setting indicates the priority given to the device. With the **Interlock** option, the device can only be used if no other device is in use. The **Admin** option allows any device currently in use to be forced into a pen up state and the device is given immediate priority.
- **Release Time** - Defines the interlock release times.
- **Use Lift-off Packet** - Only shown if a pen up data packet is generated by the device on stylus lift off.
- **Anchor Mouse** - If the device generates a pen up data packet on stylus lift, the mouse cursor returns to its original position after using the pointer device.
- **Enabled** - Indicates if the device is enabled. This is an option to free up resources without uninstalling the driver.
- **Advanced** - Includes advanced features such as, **Edge Acceleration**, **Ignore Touches Outside Calibrated Area**, **Support for New Events**, and **Portrait Rotation**.

![Properties Settings (VC80 with Windows 7)](image-url)
Calibration

- **Style** - Invoke Calibration styles manually, from an application, a toolbar, or a command line interface.
- **Add a New Style** - Add a new calibration style.
- **Number of Points** - The number of calibration points determines the calibration pattern used. It is highly recommended that four or more points are used for greater flexibility.
- **Margin %** - The percentage margin from the edge of the visual display area from which to draw the calibration points.
- **Timeout (secs)** - Specifies the number of seconds to wait for a calibration touch before canceling the calibration procedure.
- **Use Eeprom Storage** - Store calibration data in the controllers Eeprom.
- **Confirm After Calibration** - Select to use new calibration data.
- **Sound Options** - Calibration sound options.
- **Calibrate** - Invoke calibration procedure for the current device. When calibrating for the first time in a multi-monitor environment, calibrating the devices also sets up desktop/touch device relationships.

![Calibration Settings (VC80 with Windows 7)]

**Figure 3-14** Calibration Settings (VC80 with Windows 7)
**Status**

- **Controller Type** - The actual controller type in use irrespective of the name given to it in the UPDD console.
- **State** - Indicates if the device is enabled at the UPDD level.
- **Macro Result** - Shows if a controller is initialized by the driver.
- **Replay Initialization Macro** - Reinitializes the controller. The macro, if defined, is sent to the controller.
- **Reset Error Counts** - Reset the sync error count. Only enabled if error count > 0.
- **Reload Driver Settings** - Reload the driver.
- **Show Test Screen** - Invoke the test utility.
- **Show Test Grid** - Invoke the test utility with drawing grid.
- **Dump Settings** - Dump driver settings to a file. The file is useful for support purposes but can also be used in subsequent installs to define the initial settings.

![UPDD Console](image)

**Figure 3-15** Status Settings (VC80 with Windows 7)
Manage VC Configuration for VC80 Windows 7

- **Import** - Load VC configuration from file.
- **Export** - Export VC configuration to file.
- **Restore Default** - Sets all parameters to factory default.

Figure 3-16  Manage VC Configuration (VC80 with Windows 7)
Bezel Keyboard for VC80 Windows 7

- **My-T-Soft Macro Mapping** - Allows remapping and/or assigning various custom functions to the Bezel buttons.

- **Assign Bezel Key Scancodes** - Map bezel keys one of the following ways:
  - **Bezel Key** - Assign bezel key using the drop-down menu.
  - **Assign Scancodes** - Assign scancode function from drop-down menu. To change scancodes to assign unique functions/characters, see *Chapter 7, Scancode Map*.

- **Blue Key**
  - **One-Shot** - Activates the Blue key function on the first key press and remains activated until any key is pressed again.
  - **Lock** - Activates the Blue key function on the first key press and remains activated until the Blue key is pressed again.
  - **One-Shot/Lock** - Activates the Blue key function on the first key press. The second Blue key press locks the Blue key function. The third Blue key press deactivates the function.

![VC Control Panel](image)

*Figure 3-17  Bezel Keyboard Settings (VC80 with Windows 7)*
Haptic Feedback for VC80 Windows 7

- **Haptics Feedback**
  - Enable/disable Haptics Feedback.
  - Select **Full Screen** or **My-T-Soft Only**.

- **Parameters**
  - Select the haptics waveform type: **Long Double Sharp Click Waveform** or **Strong Click Waveform**.
  - Select the haptics waveform level.

![VC Control Panel](image)

**Figure 3-18**  *Haptics Feedback Settings (VC80 with Windows 7)*
Heater Status for VC80 Windows 7

The VC80 heater ensures optimum performance in freezers. The heater benefits include:

- Touch screen heater clears condensation on the display.
- Port heater prevents condensation on contacts.
- Audio Codec, UPS Battery and WLAN/BT radio require heaters to operate below freezing temperatures.
- The user interface displays current temperatures.

Heater Status settings:

- **Current Temperature** - Displays internal and external temperatures.
- **Display Temperature** - Select desired temperature scale.
- **Temperature Status**
  - Green LED - Heater is enabled.
  - Red LED - Heater is disabled.
- **Start Test** - Verifies heater operation when temperature increases.

Figure 3-19  Heater Status Settings (VC80 with Windows 7)
Power for VC80 Windows 7

- Interface Power Configuration - Enable/disable power for serial and USB ports.
  
  **NOTE** Ignition detect requires a CA1220 power extension cable.

- Vehicle Ignition Detection
  - Start VC when vehicle ignition changes from OFF to ON state.
  - Shut down VC when vehicle ignition changes from ON to OFF state.
  - Enter desired minutes to delay in the Delay field.

**Figure 3-20**  Power Settings (VC80 with Windows 7)
Push To Talk for VC80 Windows 7

- **Connection Status** - Displays the current connection status.
- **PTT Handset Scan Code** - Scan code for bezel key setting.
- **Speaker** - Enable the **Bezel Speaker** or **PTT Handset Speaker**.

![Figure 3-21  Push To Talk Settings (VC80 with Windows 7)](image-url)
Screen Blanking for VC80 Windows 7

The optional Screen Blanking setting turns the screen off when the vehicle is moving and back on when the vehicle is stopped.

**NOTE** To use Screen Blanking, first connect one of the two DB9 serial ports on the VC80 to a user-supplied switch or relay. See *Connecting Switch for Screen Blanking on page 2-10*.

- **Screen Blanking** - Enable/disable screen blanking feature.
- **Delay**
  - **Blanking the VC Screen** - Screen blanking duration in seconds.
  - **Re-Enabling the VC Screen** - Re-enable screen duration in seconds.
- **Blank Screen Based On**
  - **Com Port 1 or Com Port 2**.
  - **Blank screen when port pins are connected** - Select blank screen option. De-select to disconnect the blank screen option.

![Figure 3-22 Screen Blanking Screen (VC80 with Windows 7)](image)

Figure 3-22 Screen Blanking Screen (VC80 with Windows 7)
System Info for VC80 Windows 7

The System Info screen provides information about the system such as the **Serial Number**, **OS Details**, and **SKU Detail**. The system information is required for technical support inquiries.

To export the system information to a text file:

1. Select **Save**.
2. Select a location to save the file to.
3. Name the file in the **File Name** field.
4. Select a file type from the **Save As Type** drop-down menu.

![Figure 3-23 System Information (VC80 with Windows 7)]
TekWedge for VC80 Windows 7

TekWedge provides the ability to interface with Serial and Bluetooth scanners.

NOTE To configure a serial scanner, turn on the power to the port (see Power for VC80 Windows 7 on page 3-20) and in TekWedge settings, enable the port and TekWedge.

- TekWedge to support serial scanners - Enable/disable TekWedge support for serial and Bluetooth scanners.
- Properties
  - Enable Good Scan Beep - VC80 beeps when data is received from the scanner.
  - Code Page - Select code page from drop-down menu.
- Data Transmission - Select one type of data transmission.
  - Copy/Paste (Application supports Ctrl-V) - Copy/Paste is efficient for large amounts of scanned data.
  - Keyboard Wedge.
- Ports and Translation Rules

Figure 3-24 TekWedge Settings (VC80 with Windows 7)
- **Config Ports** - Select the **COM Port** from the ports window and adjust the port settings such as **Baud Rate**, **Data Bits**, **Parity**, **Flow Control**, **Stop Bits**, and **Timeout** as desired.
- **Set to Default** - Sets the default for the selected COM port.
- **Clear Unavailable Ports** - Clears unavailable ports such as ports that are no longer active.

![Config Ports (VC80 with Windows 7)](image)

**Figure 3-25**  *Config Ports (VC80 with Windows 7)*

**NOTE** For large bar codes, adjust the **Timeout** duration. The longer the timeout, the slower the scans.
• **Config Translation Rules** - Allows you to define up to 10 cases, each consisting of up to 10 rules in sequential order. Only one case is applied to a bar code and a case is applied if all rules specified in the case are successful. If a rule within a case fails, the entire case fails.

• **Case Rules** - The case rules are defined as follows:
  - No Rule
  - Verify Barcode Size — Verifies the barcode size. Assign this rule first, before creating subsequent rules.
  - Match at Index — Matches the match string at a specified index.
  - Add Barcode Prefix/Suffix — Adds a global prefix or suffix.
  - Search and Replace — Replaces all instances of the match string.
  - Match and Replace at Index — Matches the match string at a specified index and replaces/changes it.
  - Replace at Index — Replaces/changes unspecified data in a given range.

Translation information about the status of each case/rule is displayed in the scan log file. This is useful to determine why a rule is failing.

Select a **Case/Rule** to modify and then select the **Scan Type** drop-down menu to apply a rule.

![Scan Wedge Translation Rules Config](image)

**Figure 3-26**  *Translation Rules (VC80 with Windows 7)*
UPS Battery Status for VC80 Windows 7

- **Information** - Displays the current battery information such as the **Serial Number**, **Manufacture Date**, and **Remaining Battery Life**.
- **Notification** - Enable/disable **Low Battery Notifications** and enter a **Threshold** percentage for low battery life warnings.

![UPS Battery Settings (VC80 with Windows 7)](image)

**Figure 3-27** UPS Battery Settings (VC80 with Windows 7)
Data Logging for VC80 Windows 7

Data Logging logs information about VC80 custom features.

- **Log Information Level**
  - **Source** - Select a source from the drop-down menu such as **Heaters**, **Haptics**, **UPS Battery**.
  - **Content** - Select a priority level from the drop-down menu such a **Critical**, **Major**, **Minor**.
  - **Disable All Logging** - Removes logging VC80 custom feature information.

- **Log File Management** - Select a **Log File Location**, quantity of log files in the **Create up to** field, and disk size (default is 2 MB) in the **Total Size On Disk** field.

![Data Logging Settings (VC80 with Windows 7)](image)

**Figure 3-28**  *Data Logging Settings (VC80 with Windows 7)*

✓  **NOTE** Application crash dump files are captured and stored in a restricted folder permitted for Administrators only (C:\VC\Logs or C:\Windows\MiniDmp).
My-T-Soft

My-T-Soft offers a database of existing keyboard layouts for screen keyboard customization and key mapping. Unique custom keyboard layouts may be acquired from IMG (My-T-Soft supplier) for additional license fee(s).

Figure 3-29  My-T-Soft Screen Keyboard Layout Examples

All VC80s are My-T-Soft licensed through a common account which is only available from the VC80. The Build-A-Board tool can be downloaded to the VC80 to create custom keyboard layouts.

To access My-T-Soft:

1. Select **Start > Select My-T-Soft > Licensing Information**.

Figure 3-30  My-T-Soft License Information

2. The UAC window displays. Select **Yes**.
3. In the IMG License Manager menu, select **Go to My Build-A-Board.com Account**.

![IMG License Manager](image1)

**Figure 3-31  IMG License Manager**

4. The Zebra account web page displays. Download existing keyboards or create your own and save in the Zebra account.

5. From the Build-A-Board Zebra account page, select the **My Downloads** tab.

6. Select **Build-A-Board** to download the tool.

![Build-A-Board Zebra Account Page](image2)

**Figure 3-32  Build-A-Board Zebra Account Page**

**NOTE** Support for this tool is provided on the Build-A-Board website.

**NOTE** To create a private collection of keyboards, you must acquire your own account.
Windows Management Instrumentation

Windows Management Instrumentation (WMI) is a free component of the Microsoft Windows® operating system that provides a scalable system management infrastructure. Using a free provider plug-in from Zebra, WMI enables local and network remote management of scanner(s). System administrators can leverage WMI to query and set information on desktop systems, applications, networks, components, and accessories, such as a scanner.

For more WMI information, go to:
- http://www.zebra.com/support

GPS

U-Center is used to set up GPS on the VC80.

To set up the GPS:
1. Ensure that the antenna is properly installed on the GPS port (see Figure 1-2 on page 1-3).
2. Open U-Center by selecting Start > Program Files > U-Center.
3. Ensure that the receiver is connected. See Figure 1-2 on page 1-3. After approximately thirty seconds, some of signals bars turn to green. This signifies that the GPS has obtained 3D lock.

Figure 3-33  U-Center Connection
Satellite Level

To view the Satellite Level, select View > Docking Windows > Satellite Level.

Location Coordinates

To view Location Coordinates, select View > Docking Windows > Data.

Figure 3-34  Location Coordinates

U-Center Software

- Other applications/software such as Visual GPS can be used to collect location data by communicating with the GPS receiver.
Kiosk

The Kiosk application provides a simple lock-down mode for the Zebra VC80 and ET5X products. When activated, the standard Windows shell is replaced so that device usage is restricted to a desired application such as, a browser or custom workplace application.

The Kiosk app is included in the VC Control Panel installer. It is installed and uninstalled from the VC Control Panel. Access to Kiosk is from an icon located on the desktop.

Configuration and Activation of Kiosk Mode

Run the application directly using **Start/Run**... or by launching it from Windows Explorer. The path location is:

```
C:\Program Files\VCControlPanel\Kiosk.exe
```

The application requests administrative privileges to make the necessary changes to activate kiosk mode. Once logged in as Admin, the **Configuration & Launcher** window displays. Each section of the configuration window is detailed as follows:

**Shell Settings**

Under **Shell Settings**, click on **Browse** and select the application to be executed instead of the Windows interface. In the **Figure 3-35** example, Internet Explorer is configured. You may choose any application you desire to be the main application for Kiosk Mode.

![Figure 3-35 Kiosk Shell Settings](image)

The Shell Settings options provide enhanced control for the look and behavior of the selected application.

- **Application** - Locate the application to launch using the **Browse** button.
- **Remove Menu Bar** - Start the application without the menu bar.
- **Remove Title Bar** - Start the application without the title bar.
- **Auto Relaunch on Close** - If the application is closed by the user, it starts again automatically.
- **Maintain Focus** - Maintain the focus as the top most application launched by Kiosk.
Security

Located under Security, click on the Select Exit Key drop-down arrow to choose one of the following key combinations to be used to exit kiosk mode: CTRL+ALT+Q or CTRL+ALT+L.

When the exit kiosk mode key combinations are pressed, a window displays to Log Out or Exit kiosk mode. For both of these actions, you may require a password to be entered by selecting the Require Admin Password check box and entering a password in the Password field.

Exiting Kiosk Mode requires administrative privileges and must be done from an administrative account or by providing administrator credentials. The kiosk password is used to prevent unauthorized logging out.

![Figure 3-36  Kiosk Security Settings](image)

Lockdown

The task manager allows any application to run and be controlled manually which defeats the purpose of kiosk mode. After testing kiosk mode, it is recommended to select the Disable Task Manager check box for production use to prevent the task manager from being activated (for example, by selecting Ctrl-Alt-Delete).

![Figure 3-37  Kiosk Lockdown](image)

Monitor Utility

When kiosk mode is enabled, it displays icons that shows the Wi-Fi (WLAN) status and battery status. You can set preferences as follows:

- **Enable Monitor** - Display the signal strength (RSSI dbm).
- **Default Location** - Select a location to display the icons: Top Left, Top Right, Bottom Left, Bottom Right. Select the Fixed check box to lock the location.
- **Color Mode** - Select the drop-down menu to choose a background color: Black, White, or Transparent.
- **Show SSID** - Select to check box to display the current access point SSID
- **Show Battery Level** - Display the charge level of the battery as a capacity percentage.

You can try the settings without going into kiosk mode by saving the configuration, select Apply config, and running the monitor application manually. There is no exit button. The monitor application must be closed from the Task Manager manually. The monitor application is located at:

*C:\Program Files\VCControlPanel\WiFiMonitor.exe*

![Figure 3-38  Kiosk Monitor Utility](image)
Additional Software

- **Launch SIP** - Start the My-T-Soft on-screen keyboard when the kiosk starts. An on-screen keyboard or a physical keyboard is necessary to exit kiosk mode.
- **Enable TekWedge** - Start TekWedge when the kiosk starts. This software causes scanned bar codes to be treated as keyboard input.
- **Enable Bluetooth** - Start the WIDCOMM Bluetooth software when the kiosk starts to allow pairing (for example, Bluetooth devices).
- **Launch Custom** - To specify another custom application to start up when the kiosk starts, select the Launch Custom check box. Select **Browse** to choose the desired executable. This application is in addition to the app configured under **Shell Settings**.

![Additional Software](image)

**Figure 3-39 Additional Software**

Completing Setup

Select **Apply Config** to save your configuration settings.

To launch kiosk mode, select **Launch Kiosk** to log out and launch Kiosk mode. You need your exit key and kiosk password.

Kiosk settings are applied to the computer and then you are logged off. Kiosk mode is now active and applies to all accounts. Upon login, the configured kiosk applications run.

![Completed Kiosk Setup](image)

**Figure 3-40 Completing Kiosk Setup**

Exiting Kiosk Mode

To log off or exit kiosk mode:

1. Press the key combination (see *Security on page 3-34*) to access the Kiosk Control.
2. If security was configured to require a password, enter your password for both of the following actions.
   - **Log Off** - Logs off of the account to exit all open applications.
   - **Exit Kiosk** - Deactivates kiosk mode. Administrative privileges are required. Accept the *Run-as-Administrator* request and supply administrative account credentials if exiting from a non-administrative account. Kiosk settings are removed from the computer and you are logged off. Kiosk mode is no longer active for any account. Upon login, the Windows shell runs.

![Exit Kiosk Mode](image)

**Figure 3-41 Exit Kiosk Mode**
Launching Applications without UAC Prompt

To launch applications without the UAC prompt:

1. Find the installation path of the application (for example, C:\Program Files\ApplicationName) and right click on the application EXE file.

2. Select Properties.

3. Select the Compatibility Tab.

4. Check the option Run this Program as an Administrator.
Introduction

This chapter provides software information and instruction for the VC80 with Windows 10.

Microsoft Windows Setup and Configuration

After the system files are processed, Microsoft Windows loads. Standard Windows configuration options apply to the VC80. Configuration options are located in the System Tray or the Control Panel. For example, use the System Tray to adjust the time, date or volume level and the Control Panel to add, delete or modify software.

Folder Structure

Microsoft Windows is installed in the \Windows folder. For information on the folder structure, refer to the commercially available Microsoft Windows OS Reference Guide.
VC80 Windows 10 Software Components

The VC80 contains the following software components:

- BIOS
- Embedded Controller firmware
- Microsoft Operating System (Windows 10 IoT Enterprise 2016 LTSB Entry).
- VC Control Panel

The following Windows OS features are unique to the VC80 (dependent on configuration):

- Touch driver
- WLAN/Bluetooth driver
- Ethernet driver
- GPS
- Zebra printer drivers and tools.

The Embedded Controller manages communication with the following VC80 unique features:

- Heaters
- Battery state
- Haptics
- Vehicle ignition detection.

VC80 Windows 10 Without Operating System

The VC80 can be ordered with no operating system. This configuration requires the user to obtain the following:

- Windows 10 installation media
- A valid product licensing key.

When prompted for driver locations during installation and setup, direct the device wizard to the USB drive containing the VC80 specific drivers.

- For Windows 10 drivers, go to: www.zebra.com/support.
Connecting VC80 Windows 10 to Terminal Emulation

The VC80 supports terminal emulators such as TekTerm. For connection to a host, have the following information available:

- Alias name or IP host address
- Port number of the host system
- Emulation.

To connect to a host:
1. Ensure the mobile client network settings are correctly configured.
2. Ensure the VC80 is connected to the network if connecting via WLAN.
3. Launch the terminal emulation application.

TekTerm

TekTerm is a powerful terminal emulation software application with the ability to interface with multiple Bluetooth and serial scanners. TekTerm is pre-licensed and pre-installed on the VC80.

It is recommended to check the latest TekTerm version released for the VC80. For more information regarding TekTerm, go to: www.zebra.com/support.
VC80 Windows 10 Bar Code Scanners and Settings

The VC80 supports the following types of bar code scanners:

- Tethered scanner connected to COM1 or COM2.
- Tethered scanner connected to a USB host port
- Wireless scanner connected via Bluetooth.

Serial Scanners for VC80 Windows 10

To configure serial scanners:

1. Open the VC Control Panel and select **Power**.
2. Enable the power to the port.

![VC Control Panel](image)

*Figure 4-1  Enable Power for Serial Scanners (VC80 with Windows 10)*
3. Select TekWedge and select **Enable TekWedge to support serial scanners**.

4. Under **Properties**, make the following selections:
   - **Enable Good Scan Beep** - When enabled, a beep sounds upon a successful decode. When disabled, a beep does not sound upon a successful decode.
   - **Ignore Caps Lock and Shift** - When enabled, the state of Caps Lock and Shift keys do not affect the data received from the scanner. When disabled, the scanner data may be converted to upper/lower case based on the current state of the Caps Lock and Shift Keys.

5. Select **Config Ports**.

![Image](figure4-2.png)

**Figure 4-2** Enable TekWedge for Serial Scanners (VC80 with Windows 10)

6. Select the new COM port and select **Enable Port**.

![Image](figure4-3.png)

**Figure 4-3** Enable Port for Serial Scanner (VC80 with Windows 10)

7. Select **OK**.
USB Scanners for VC80 Windows 10

The Windows OS loads a USB driver for USB scanners. USB scanners are not controlled or managed by TekWedge therefore, post processing such as translation rules can not be used with USB scanners. 123Scan² can be used to create rules and download to the scanner.

To configure USB scanners, connect the scanner to the VC80 USB port and follow the scanner setup instructions. For Zebra scanner guides, go to: www.zebra.com/support.

Bluetooth Scanners for VC80 Windows 10

See Quick Setup for VC80 Windows 10 on page 4-10 for information on connecting Bluetooth scanners. Always use TekWedge for VC80 Windows 10 on page 4-25 to configure Bluetooth parameters.

Pairing Bluetooth Scanners Using Bar Codes for VC80 Windows 10

✓ NOTE If the Bluetooth scanner connection to the VC80 is lost, it is recommended to first scan the Unpair bar code and then scan the Pair bar code.

To pair Bluetooth scanners using bar codes:

1. Right or left click on the Bluetooth icon in the system tray.

2. Select Open Settings to access Bluetooth settings.
3. In the **Options** tab, select check boxes under **Discovery** and **Connections**.

![Bluetooth Settings](image)

**Figure 4-5**  *Bluetooth Discovery and Connections (VC80 with Windows 10)*

4. In the **COM Ports** tab, select **Add**.

5. Select the radio button **Incoming (device initiates the connection)**.

6. Select **OK**.

![Add COM Port](image)

**Figure 4-6**  *Add Incoming Bluetooth Devices (VC80 with Windows 10)*
7. Open the VC Control Panel and select **TekWedge**.

8. Enable **TekWedge**.

9. Select **Config Ports**.

   ![Figure 4-7] Enable TekWedge (VC80 with Windows 10)

10. Select the new COM port and select **Enable Port**.

    ![Figure 4-8] Enable COM Port for Bluetooth Device (VC80 with Windows 10)

11. Select **OK**.

12. Scan the bar code to pair the scanner (the scanner must be configured for SPP mode).
Settings for VC80 Windows 10

Select **Start Menu > Admin Tools > VC Control Panel** to configure the following VC80 settings:

- Quick Setup
- Bezel Keypad
- Haptics Feedback
- Heater Status
- Power
- Push to Talk
- Screen Blanking
- System Info
- TekWedge
- UPS Battery
- Data Logging

![VC Control Panel](image)

**Figure 4-9** VC80 Settings (VC80 with Windows 10)
Quick Setup for VC80 Windows 10

Select **Start Menu > VC Control Panel > Quick Setup** to configure the following quick setup options.

Links to Microsoft or third party utilities:

- **Touch Panel Calibration** - Calibrate the touch panel.
- **WLAN Configuration** - Configure WLAN.
- **Network Configuration** - Configure network parameters such as, Static IP address and DHCP.
- **On-Screen Keyboard Configuration** - My-T-Soft Keyboard configuration.

VC80 control panel:

- **Manage VC Configuration** - Load, save, or restore default configuration files.

Figure 4-10  Quick Setup Settings (VC80 with Windows 10)
Touch Panel Calibration for VC80 Windows 10

**Hardware**

Associates the pointer device with the monitor/desktop area that is controlled by the device and shows the hardware port information.

- **Handling Whole Desktop** - Whole indicates the primary monitor.
- **Connected to USB Port** - Displays the port connected to the device.
- **Add a New Device** - Option to add a device. Only non USB devices are manually added. USB devices are automatically added.
- **Remove this Device** - Option to remove a device. Only non USB or inactive USB are manually removed.

**NOTE** Select Help for detailed information on the Touch Panel Calibration options.

---

**Figure 4-11** Hardware Settings (VC80 with Windows 10)
**Click Mode**

- **Interactive Touch** - Shows the current click mode emulation for a single touch. The setting is only active if the driver is responsible for the pointer handling via the standard mouse interface into the OS.
- **Extended Touch** - Vista and above, UPDD can deliver touch co-ordinate data to the Windows OS via three interfaces: mouse class, HID class, Win8TI API interface.
- **Visual Notification** - Indicates if visual feedback is shown during Interactive Touch right click countdown.
- **Interactive Switch Delay** - Select the delay pace.
- **Sound Options** - Configure touch sound options.
- **System Mouse Settings** - Adjust the mouse pointer settings defined within the OS.
- **Test Icons** - Test Right Click and Double Click. A tick is shown if the click test is successful.

![UPDD Console](image)

Figure 4-12 Click Mode Settings (VC80 with Windows 10)
Properties

- **Name** - Associates a name to the device. By default the name is the drivers controller device name.
- **Low Pass Filter** - Applies a filter to produce a smoother drawing. The speed of drawing is affected, the higher the value used.
- **Liftoff Time** - Specifies the time interval required to register a stylus lift after the last touch packet is received. Lift off time is defined in units of 10ms.
- **Stabilization** - Causes small movements to be ignored.
- **Averaging** - Applies a filter to produce smoother drawings. Filtering can improve drawing without affecting the drawing speed.
- **Mode** - In a multi pointer device environment, this setting indicates the priority given to the device. With the Interlock option, the device can only be used if no other device is in use. The Admin option allows any device currently in use to be forced into a pen up state and the device is given immediate priority.
- **Release Time** - Defines the interlock release times.
- **Use Lift-off Packet** - Only shown if a pen up data packet is generated by the device on stylus lift off.
- **Anchor Mouse** - If the device generates a pen up data packet on stylus lift, the mouse cursor returns to its original position after using the pointer device.
- **Enabled** - Indicates if the device is enabled. This is an option to free up resources without uninstalling the driver.
- **Advanced** - Includes advanced features such as, Edge Acceleration, Ignore Touches Outside Calibrated Area, Support for New Events, and Portrait Rotation.

![UPDD Console](image)

Figure 4-13  Properties Settings (VC80 with Windows 10)
Calibration

- **Style** - Invoke Calibration styles manually, from an application, a toolbar, or a command line interface.
- **Add a New Style** - Add a new calibration style.
- **Number of Points** - The number of calibration points determines the calibration pattern used. It is highly recommended that four or more points are used for greater flexibility.
- **Margin %** - The percentage margin from the edge of the visual display area from which to draw the calibration points.
- **Timeout (secs)** - Specifies the number of seconds to wait for a calibration touch before canceling the calibration procedure.
- **Use Eeprom Storage** - Store calibration data in the controller's Eeprom.
- **Confirm After Calibration** - Select to use new calibration data.
- **Sound Options** - Calibration sound options.
- **Calibrate** - Invoke calibration procedure for the current device. When calibrating for the first time in a multi-monitor environment, calibrating the devices also sets up desktop/touch device relationships.

![Calibration Settings (VC80 with Windows 10)](image)

**Figure 4-14** Calibration Settings (VC80 with Windows 10)
**Status**

- **Controller Type** - The actual controller type in use irrespective of the name given to it in the UPDD console.
- **State** - Indicates if the device is enabled at the UPDD level.
- **Macro Result** - Shows if a controller is initialized by the driver.
- **Replay Initialization Macro** - Reinitializes the controller. The macro, if defined, is sent to the controller.
- **Reset Error Counts** - Reset the sync error count. Only enabled if error count > 0.
- **Reload Driver Settings** - Reload the driver.
- **Show Test Screen** - Invoke the test utility.
- **Show Test Grid** - Invoke the utility with drawing grid.
- **Dump Settings** - Dump driver settings to a file. The file is useful for support purposes but can also be used in subsequent installs to define the initial settings.

---

![UPDD Console](image)

**Figure 4-15** *Status Settings (VC80 with Windows 10)*
Manage VC Configuration for VC80 Windows 10

- **Import** - Load VC configuration from file.
- **Export** - Export VC configuration to file.
- **Restore Default** - Sets all parameters to factory default.

*Figure 4-16  Manage VC Configuration (VC80 with Windows 10)*
Accelerometer for VC80 Windows 10

Log File Management

- **Accelerometer Data Logging** - Measures device acceleration and logs the data.
  - Enable/disable **Accelerometer Data Logging** using the slider.
  - Select the **Log File Location** using **Browse** button.
  - Enter the number of log files to create (1-30).
  - **Total Size on Disk** is calculated automatically by multiplying the number of log files by 2 MB each.

Log File Content

**NOTE**  Thresholds are rounded to the nearest 0.25 G.

- Select **Log Events** for impact and motion related events.
  - Select the **Impact Detection Threshold** using the slider or enter the quantity.
  - Select the **Motion Detection Threshold** using the slider or enter the quantity.
- Select **Log Raw Data** which exceeds the Data Threshold.
  - Select the **Data Threshold** using the slider or enter the quantity.
  - Enter data **Sampling Interval** ms (100-2,000).

Figure 4-17   **Accelerometer Settings (VC80 with Windows 10)**
Bezel Keyboard for VC80 Windows 10

- **My-T-Soft Macro Mapping** - Allows remapping and/or assigning various custom functions to the Bezel buttons.

- **Assign Bezel Key Scancodes** - Map bezel keys one of the following ways:
  - **Bezel Key** - Assign bezel key using the drop-down menu.
  - **Assign Scancodes** - Assign scancode function from drop-down menu. To change scancodes to assign unique functions/characters, see *Chapter 7, Scancode Map*.

- **Blue Key**
  - **One-Shot** - Activates the Blue key function on the first key press and remains activated until any key is pressed again.
  - **Lock** - Activates the Blue key function on the first key press and remains activated until the Blue key is pressed again.
  - **One-Shot/Lock** - Activates the Blue key function on the first key press. The second Blue key press locks the Blue key function. The third Blue key press deactivates the function.

![Bezel Keyboard Settings (VC80 with Windows 10)](image)

Figure 4-18  Bezel Keyboard Settings (VC80 with Windows 10)
Haptic Feedback for VC80 Windows 10

- Haptics Feedback
  - Enable/disable Haptics Feedback.
  - Select Full Screen or My-T-Soft Only.

![Haptics Feedback Settings (VC80 with Windows 10)](image)

**Figure 4-19**  *Haptics Feedback Settings (VC80 with Windows 10)*
Heater Status for VC80 Windows 10

The VC80 heater ensures optimum performance in freezers. The heater benefits include:

- Touch screen heater clears condensation on the display.
- Port heater prevents condensation on contacts.
- Audio Codec, UPS Battery and WLAN/BT radio require heaters to operate below freezing temperatures.
- The user interface displays current temperatures.

Heater Status settings:

- **Current Temperature** - Displays internal and external temperatures.
- **Display Temperature** - Select desired temperature scale.
- **Temperature Status**
  - Green LED - Heater is enabled.
  - Red LED - Heater is disabled.
- **Start Test** - Verifies heater operation when temperature increases.

![Figure 4-20](image_url)  
*Heater Status Settings (VC80 with Windows 10)*
Power for VC80 Windows 10

- **Interface Power Configuration** - Enable/disable power for serial and USB ports.

  **NOTE** To configure a serial scanner, turn on the power to the port and in TekWedge settings, enable the port and TekWedge (see *TekWedge for VC80 Windows 10* on page 4-25).

- **Vehicle Ignition Detection**
  - Start VC when vehicle ignition changes from OFF to ON state.
  - Shut down VC when vehicle ignition changes from ON to OFF state.
  - Enter desired minutes to delay in the **Delay** field.

![VC Control Panel](image)

**Figure 4-21**  *Power Settings (VC80 with Windows 10)*

**NOTE** Ignition detect requires a CA1220 power extension cable.
Push To Talk for VC80 Windows 10

- **Connection Status** - Displays the current connection status.
- **PTT Handset Scan Code** - Scan code for bezel key setting.
- **Speaker** - Enable the Bezel Speaker or PTT Handset Speaker.

**Figure 4-22**  *Push To Talk Settings (VC80 with Windows 10)*
Screen Blanking for VC80 Windows 10

The optional Screen Blanking setting turns the screen off when the vehicle is moving and back on when the vehicle is stopped.

NOTE  To use Screen Blanking, first connect one of the two DB9 serial ports on the VC80 to a user-supplied switch or relay. See Connecting Switch for Screen Blanking on page 2-10.

• Screen Blanking - Enable/disable screen blanking feature.

• Delay
  • Blanking the VC Screen - Screen blanking duration in seconds.
  • Re-Enabling the VC Screen - Re-enable screen duration in seconds.

• Blank Screen Based On
  • Com Port 1 or Com Port 2.
  • Blank screen when port pins are connected - Select blank screen option. De-select to disconnect the blank screen option.

![Screen Blanking Screen (VC80 with Windows 10)](image_url)

Figure 4-23  Screen Blanking Screen (VC80 with Windows 10)
System Info for VC80 Windows 10

The System Info screen provides information about the system such as the Serial Number, OS Details, and SKU Detail. The system information is required for technical support inquiries.

To export the system information to a text file:
1. Select Save.
2. Select a location to save the file to.
3. Name the file in the File Name field.
4. Select a file type from the Save As Type drop-down menu.

![System Information (VC80 with Windows 10)](image)

Figure 4-24  System Information (VC80 with Windows 10)
TekWedge for VC80 Windows 10

TekWedge provides the ability to interface with Serial and Bluetooth scanners.

NOTE To configure a serial scanner, turn on the power to the port (see Power for VC80 Windows 10 on page 4-21) and in TekWedge settings, enable the port and TekWedge.

- TekWedge to support serial scanners - Enable/disable TekWedge support for serial and Bluetooth scanners.

- Properties
  - Enable Good Scan Beep - VC80 beeps when data is received from the scanner.
  - Code Page - Select code page from drop-down menu.

- Data Transmission - Select one type of data transmission.
  - Copy/Paste (Application supports Ctrl-V) - Copy/Paste is efficient for large amounts of scanned data.
  - Keyboard Wedge.

- Ports and Translation Rules

Figure 4-25  TekWedge Settings (VC80 with Windows 10)
• **Config Ports** - Select the **COM Port** from the ports window and adjust the port settings such as **Baud Rate**, **Data Bits**, **Parity**, **Flow Control**, **Stop Bits**, and **Timeout** as desired.

• **Set to Default** - Sets the default for the selected COM port.

• **Clear Unavailable Ports** - Clears unavailable ports such as ports that are no longer active.

![Config Ports (VC80 with Windows 10)](image)

**Figure 4-26**  *Config Ports (VC80 with Windows 10)*

✓ **NOTE**  For large bar codes, adjust the **Timeout** duration. The longer the timeout, the slower the scans.
• **Config Translation Rules** - Allows you to define up to 10 cases, each consisting of up to 10 rules in sequential order. Only one case is applied to a bar code and a case is applied if all rules specified in the case are successful. If a rule within a case fails, the entire case fails.

• **Case Rules** - The case rules are defined as follows:
  - No Rule
  - **Verify Barcode Size** — Verifies the barcode size. Assign this rule first, before creating subsequent rules.
  - **Match at Index** — Matches the match string at a specified index.
  - **Add Barcode Prefix/Suffix** — Adds a global prefix or suffix.
  - **Search and Replace** — Replaces all instances of the match string.
  - **Match and Replace at Index** — Matches the match string at a specified index and replaces/changes it.
  - **Replace at Index** — Replaces/changes unspecified data in a given range.

Translation information about the status of each case/rule is displayed in the scan log file. This is useful to determine why a rule is failing.

Select a **Case/Rule** to modify and then select the **Scan Type** drop-down menu to apply a rule.

---

**Figure 4-27**  Translation Rules (VC80 with Windows 10)
UPS Battery Status for VC80 Windows 10

- **Information** - Displays the current battery information such as the **Serial Number**, **Manufacture Date**, and **Remaining Battery Life**.

- **Notification** - Enable/disable **Low Battery Notifications** and enter a **Threshold** percentage for low battery life warnings.

*Figure 4-28  UPS Battery Settings (VC80 with Windows 10)*
Data Logging for VC80 Windows 10

Data Logging logs information about VC80 custom features.

- **Log Information Level**
  - **Source** - Select a source from the drop-down menu such as **Heaters**, **Haptics**, **UPS Battery**.
  - **Content** - Select a priority level from the drop-down menu such as **Critical**, **Major**, **Minor**.
  - **Disable All Logging** - Removes logging VC80 custom feature information.

- **Log File Management** - Select a **Log File Location**, quantity of log files in the **Create up to** field, and disk size (default is 2 MB) in the **Total Size On Disk** field.

![VC Control Panel Data Logging Settings](image)

**Figure 4-29 Data Logging Settings (VC80 with Windows 10)**

**NOTE** Application crash dump files are captured and stored in a restricted folder permitted for Administrators only (C:\VC\Logs or C:\Windows\MiniDmp).
My-T-Soft

My-T-Soft offers a database of existing keyboard layouts for screen keyboard customization and key mapping. Each VC80 has access to a Zebra account on the Build a Board website for keyboard layouts. Unique custom keyboard layouts may be acquired for additional license fee(s).

To access My-T-Soft, go to: www.build-a-board.com.

Figure 4-30  My-T-Soft Screen Keyboard Layout Examples
All VC80s are My-T-Soft licensed through a common account which is only available from the VC80.

To access My-T-Soft:

1. Select Start > Select My-T-Soft > Licensing Information.

2. The UAC window displays. Select Yes.

3. In the IMG License Manager menu, select Go to My Build-A-Board.com Account.

4. The Zebra account web page displays. Download existing keyboards or create your own and save in the Zebra account.

   NOTE To create a private collection of keyboards, you must acquire your own account.
Windows Management Instrumentation

Windows Management Instrumentation (WMI) is a free component of the Microsoft Windows® operating system that provides a scalable system management infrastructure. Using a free provider plug-in from Zebra, WMI enables local and network remote management of scanner(s). System administrators can leverage WMI to query and set information on desktop systems, applications, networks, components, and accessories, such as a scanner.

For more WMI information, go to:
- http://www.zebra.com/support

GPS

U-Center is used to set up GPS on the VC80.

To set up the GPS:

1. Ensure that the antenna is properly installed on the GPS port (see Figure 1-2 on page 1-3).
2. Open U-Center by selecting Start > Program Files > U-Center.
3. Ensure that the receiver is connected. See Figure 1-2 on page 1-3. After approximately thirty seconds, some of signals bars turn to green. This signifies that the GPS has obtained 3D lock.

Figure 4-33  U-Center Connection
**Satellite Level**

To view the Satellite Level, select View > Docking Windows > Satellite Level.

**Location Coordinates**

To view Location Coordinates, select View > Docking Windows > Data.

![Location Coordinates](image)

**Figure 4-34  Location Coordinates**

**U-Center Software**

- For detailed U-Center information, refer to the *U-Center User Guide* at:  

- Other applications/software such as Visual GPS can be used to collect location data by communicating with the GPS receiver.
Kiosk

The Kiosk application provides a simple lock-down mode for the Zebra VC80 and ET5X products. When activated, the standard Windows shell is replaced so that device usage is restricted to a desired application such as, a browser or custom workplace application.

The Kiosk app is included in the VC Control Panel installer. It is installed and uninstalled from the VC Control Panel. Access to Kiosk is from an icon located on the desktop.

Configuration and Activation of Kiosk Mode

Run the application directly using Start/Run… or by launching it from Windows Explorer. The path location is:

C:\Program Files\VCControlPanel\Kiosk.exe

The application requests administrative privileges to make the necessary changes to activate kiosk mode. Once logged in as Admin, the Configuration & Launcher window displays. Each section of the configuration window is detailed as follows:

Shell Settings

Under Shell Settings, click on Browse and select the application to be executed instead of the Windows interface. In the Figure 4-35 example, Internet Explorer is configured. You may choose any application you desire to be the main application for Kiosk Mode.

Figure 4-35  Kiosk Shell Settings

The Shell Settings options provide enhanced control for the look and behavior of the selected application.

- Application - Locate the application to launch using the Browse button.
- Remove Menu Bar - Start the application without the menu bar.
- Remove Title Bar - Start the application without the title bar.
- Auto Relaunch on Close - If the application is closed by the user, it starts again automatically.
- Maintain Focus - Maintain the focus as the top most application launched by Kiosk.
Security

Located under **Security**, click on the **Select Exit Key** drop-down arrow to choose one of the following key combinations to be used to exit kiosk mode: **CTRL+ALT+Q** or **CTRL+ALT+L**.

When the exit kiosk mode key combinations are pressed, a window displays to **Log Out** or **Exit** kiosk mode. For both of these actions, you may require a password to be entered by selecting the **Require Admin Password** check box and entering a password in the **Password** field.

Exiting Kiosk Mode requires administrative privileges and must be done from an administrative account or by providing administrator credentials. The kiosk password is used to prevent unauthorized logging out.

![Security Settings](image)

**Figure 4-36  Kiosk Security Settings**

Lockdown

The task manager allows any application to run and be controlled manually which defeats the purpose of kiosk mode. After testing kiosk mode, it is recommended to select the **Disable Task Manager** check box for production use to prevent the task manager from being activated (for example, by selecting Ctrl-Alt-Delete).

![Lockdown](image)

**Figure 4-37  Kiosk Lockdown**

Monitor Utility

When kiosk mode is enabled, it displays icons that shows the Wi-Fi (WLAN) status and battery status. You can set preferences as follows:

- **Enable Monitor** - Display the signal strength (RSSI dbm).
- **Default Location** - Select a location to display the icons: Top Left, Top Right, Bottom Left, Bottom Right. Select the **Fixed** check box to lock the location.
- **Color Mode** - Select the drop-down menu to choose a background color: Black, White, or Transparent.
- **Show SSID** - Select to check box to display the current access point SSID
- **Show Battery Level** - Display the charge level of the battery as a capacity percentage.

You can try the settings without going into kiosk mode by saving the configuration, select **Apply config**, and running the monitor application manually. There is no exit button. The monitor application must be closed from the Task Manager manually. The monitor application is located at:

**C:\Program Files\VCControlPanel\WiFiMonitor.exe**

![Monitor Utility](image)

**Figure 4-38  Kiosk Monitor Utility**
Additional Software

- **Launch SIP** - Start the My-T-Soft on-screen keyboard when the kiosk starts. An on-screen keyboard or a physical keyboard is necessary to exit kiosk mode.
- **Enable TekWedge** - Start TekWedge when the kiosk starts. This software causes scanned bar codes to be treated as keyboard input.
- **Enable Bluetooth** - Start the WIDCOMM Bluetooth software when the kiosk starts to allow pairing (for example, Bluetooth devices).
- **Launch Custom** - To specify another custom application to start up when the kiosk starts, select the Launch Custom check box. Select Browse to choose the desired executable. This application is in addition to the app configured under Shell Settings.

![Additional Software](image)

Figure 4-39  Additional Software

Completing Setup

Select **Apply Config** to save your configuration settings.

To launch kiosk mode, select **Launch Kiosk** to log out and launch Kiosk mode. You need your exit key and kiosk password.

Kiosk settings are applied to the computer and then you are logged off. Kiosk mode is now active and applies to all accounts. Upon login, the configured kiosk applications run.

![Completing Kiosk Setup](image)

Figure 4-40  Completing Kiosk Setup

Exiting Kiosk Mode

To log off or exit kiosk mode:

1. Press the key combination (see Security on page 4-35) to access the Kiosk Control.
2. If security was configured to require a password, enter your password for both of the following actions.
   - **Log Off** - Logs off of the account to exit all open applications.
   - **Exit Kiosk** - Deactivates kiosk mode. Administrative privileges are required. Accept the Run-as-Administrator request and supply administrative account credentials if exiting from a non-administrative account. Kiosk settings are removed from the computer and you are logged off. Kiosk mode is no longer active for any account. Upon login, the Windows shell runs.

![Exit Kiosk Mode](image)

Figure 4-41  Exit Kiosk Mode
Launching Applications without UAC Prompt

To launch applications without the UAC prompt:

1. Find the installation path of the application (for example, C:\Program Files\ApplicationName) and right click on the application EXE file.
2. Select Properties.
3. Select the Compatibility Tab.
4. Check the option Run this Program as an Administrator.
CHAPTER 5 MAINTENANCE AND TROUBLESHOOTING

Introduction

This chapter includes instructions on cleaning the device and provides troubleshooting solutions for potential problems during device operations.

WARNING Danger due to electric shock when cleaning and maintaining the device. To avoid electric shock, turn the VC80 off and disconnect it from the power supply before cleaning or maintaining it.

Cleaning

CAUTION Do not use compressed air, a high-pressure cleaner or vacuum cleaner, as this can damage the surface. Using a high-pressure cleaner poses the additional risk of water entering the device and damaging the electronics or display.

Housing Cleaning

Clean the fully assembled VC80 vehicle mount computer housing using only a mild detergent on a lightly dampened soft cloth.

Touchscreen Cleaning

- Use neutral detergent or isopropyl alcohol on a clean soft cloth to clean the panel surface. Do not use any kind of chemical solvent, acidic or alkali solution.
The VC80 is equipped with a resistive touchscreen.

**CAUTION** - Keep the touchscreen clean (see *Touchscreen Cleaning on page 5-1*).
- Do not apply adhesives to the surface.
- Avoid high voltage and/or static charge.
- Do not use ball point pens, writing utensils, tools, or sharp objects.
- Touch the panel with your finger or stylus only to ensure normal operation.
- Operate in a stable environment. Abrupt variation of temperature and humidity may cause malfunction.
- Avoid applying excessive activation force or sudden impact on the touchscreen surface.

Operation of the resistive touchscreen is recommended with:

- Clean, dry fingers.
- Clean, dry, soft gloves.
- Suitable touch stylus (plastic or wood, rounded tip).
## Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The vehicle computer does not power on or shuts off suddenly.</td>
<td>The power cable ignition sense wire (yellow) is not connected properly.</td>
<td>Verify that the power cable is connected properly. See <em>Wiring Vehicle Power to the VC80 on page 2-4.</em></td>
</tr>
<tr>
<td></td>
<td>Power cable not connected properly or unplugged.</td>
<td>Connect power cable to power cable portion underside of vehicle computer. Turn the main power switch on.</td>
</tr>
<tr>
<td></td>
<td>If the vehicle computer is powered by a vehicle battery, the vehicle battery is depleted.</td>
<td>Replace or charge the vehicle battery.</td>
</tr>
<tr>
<td>Cannot see characters on display.</td>
<td>Vehicle computer not powered on (Power LED is Off).</td>
<td>Press the Power button on.</td>
</tr>
<tr>
<td></td>
<td>Screen is too bright/dark.</td>
<td>Adjust the brightness; see <em>Figure 1-1 on page 1-3.</em></td>
</tr>
<tr>
<td></td>
<td>Display not adjusted properly.</td>
<td>Select Display in the Control Panel settings and adjust the display.</td>
</tr>
<tr>
<td></td>
<td>The vehicle computer is in low power mode (Power LED is on).</td>
<td>Press the Power button to turn on the vehicle computer.</td>
</tr>
<tr>
<td>The touchscreen is not working.</td>
<td>Display not properly calibrated.</td>
<td>Recalibrate the screen through the Touch Panel Calibration utility (see <em>Touch Panel Calibration for VC80 Windows 7 on page 3-11</em>). If problem continues, contact Zebra support. See <em>Service Information on page ii-xii.</em></td>
</tr>
<tr>
<td></td>
<td>Replacement screen protector was not applied correctly.</td>
<td>Replace or re-apply screen protector.</td>
</tr>
</tbody>
</table>
### Table 5-1  Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The optional serial scanner does not operate.</td>
<td>Scanner is not properly connected to the vehicle computer.</td>
<td>Connect the scanner to the COM1 port. Ensure the proper COM port is selected in the TekWedge application, see <em>TekWedge for VC80 Windows 7 on page 3-24</em>. If the problem continues, refer to the scanner Product Reference Guide.</td>
</tr>
<tr>
<td>TekWedge application is not enabled or set to the correct COM Port.</td>
<td></td>
<td>Ensure that the TekWedge application is enabled and set to the correct port. See <em>TekWedge for VC80 Windows 7 on page 3-24</em>.</td>
</tr>
<tr>
<td>External power is not connected.</td>
<td></td>
<td>Verify external power connection.</td>
</tr>
<tr>
<td>No sound is heard when you tap the touchscreen or press a key.</td>
<td>Volume is turned down.</td>
<td>Adjust the volume in the Control Panel.</td>
</tr>
<tr>
<td></td>
<td>Application currently running disabled the sound.</td>
<td>Configure the application to enable the sound.</td>
</tr>
<tr>
<td></td>
<td>Faulty speaker.</td>
<td>Contact Zebra support at <a href="http://www.zebra.com/support">www.zebra.com/support</a>.</td>
</tr>
<tr>
<td></td>
<td>The optional M1000 speakerphone/mic is connected to the VC80.</td>
<td>Normal operation, sound is through speaker / mic.</td>
</tr>
<tr>
<td>Missing pixels on the display.</td>
<td>Faulty LCD.</td>
<td>Contact Zebra support at <a href="http://www.zebra.com/support">www.zebra.com/support</a>.</td>
</tr>
<tr>
<td>COM1 or COM2 port is not working.</td>
<td>Another application, or SerialWedge is using the port.</td>
<td>Stop the application using the port or change the TekWedge COM Port Settings.</td>
</tr>
<tr>
<td>No keys are working on the optional or built-in keyboard.</td>
<td>The optional keyboard is not properly connected to the vehicle computer.</td>
<td>Check the cable connections between the keyboard and the vehicle computer.</td>
</tr>
<tr>
<td></td>
<td>The application does not require keyboard input.</td>
<td>Configure the application to use the keyboard.</td>
</tr>
<tr>
<td></td>
<td>Vehicle computer is not responding.</td>
<td>Warm boot the vehicle computer.</td>
</tr>
</tbody>
</table>
The vehicle computer cannot find any Bluetooth devices nearby.
- Too far from other Bluetooth devices. Move closer to the other Bluetooth device(s).
- The Bluetooth device(s) nearby are not turned on. Turn on the Bluetooth device(s).
- The Bluetooth device(s) are not in discoverable mode. Set the Bluetooth device(s) to discoverable mode. If needed, refer to the device’s user documentation for help.

The Bluetooth scanner does not pair. Provides the wrong beep sequence after scanning pair bar code.
- The COM ports are not configured correctly; There is no BT incoming port; The incoming port is not enabled in TekWedge. Enable incoming port in TekWedge > Ports Config Bluetooth Scanners for VC80 Windows 7 on page 3-6 or Bluetooth Scanners for VC80 Windows 10 on page 4-6.
- Bluetooth COM port is disabled while connected to TekWedge. To re-establish a connection:
  1. Disable the BT incoming COM port
  2. Disable this same COM port in TekWedge > Port Config >
  3. Unpair the scanner.
  4. Reboot the VC80.
  5. Reconfigure according to Bluetooth Scanners for VC80 Windows 7 on page 3-6 or Bluetooth Scanners for VC80 Windows 10 on page 4-6.

When installed on some electric forklifts, the scanner range is shorter than it is when installed on other forklifts.
- Electro-magnetic interference caused by the forklift. Consult forklift vendor about reducing the interference by adding a capacitor between the forklift chassis and its battery’s negative terminal, or another recommended solution.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The vehicle computer cannot find any Bluetooth devices nearby.</td>
<td>Too far from other Bluetooth devices.</td>
<td>Move closer to the other Bluetooth device(s).</td>
</tr>
<tr>
<td></td>
<td>The Bluetooth device(s) nearby are not turned on.</td>
<td>Turn on the Bluetooth device(s).</td>
</tr>
<tr>
<td></td>
<td>The Bluetooth device(s) are not in discoverable mode.</td>
<td>Set the Bluetooth device(s) to discoverable mode. If needed, refer to the device’s user documentation for help.</td>
</tr>
<tr>
<td>The Bluetooth scanner does not pair. Provides the wrong beep sequence after scanning pair bar code.</td>
<td>The COM ports are not configured correctly; There is no BT incoming port; The incoming port is not enabled in TekWedge.</td>
<td>Enable incoming port in TekWedge &gt; Ports Config Bluetooth Scanners for VC80 Windows 7 on page 3-6 or Bluetooth Scanners for VC80 Windows 10 on page 4-6.</td>
</tr>
<tr>
<td></td>
<td>Bluetooth COM port is disabled while connected to TekWedge.</td>
<td>To re-establish a connection:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Disable the BT incoming COM port</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Disable this same COM port in TekWedge &gt; Port Config &gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Unpair the scanner.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Reboot the VC80.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5. Reconfigure according to Bluetooth Scanners for VC80 Windows 7 on page 3-6 or Bluetooth Scanners for VC80 Windows 10 on page 4-6.</td>
</tr>
<tr>
<td>When installed on some electric forklifts, the scanner range is shorter than it is when installed on other forklifts.</td>
<td>Electro-magnetic interference caused by the forklift.</td>
<td>Consult forklift vendor about reducing the interference by adding a capacitor between the forklift chassis and its battery’s negative terminal, or another recommended solution.</td>
</tr>
</tbody>
</table>
CHAPTER 6 ACCESSORIES AND MOUNTING

Introduction

This chapter provides accessory information, mounting options and instructions.

Accessories

Table 6-1  Accessories

<table>
<thead>
<tr>
<th>Model Number</th>
<th>Accessory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Antennas</td>
<td></td>
</tr>
<tr>
<td>AN2010</td>
<td>Antenna, dual band, 802.11 a/b/g/n, 2 dBi, reverse polarity SMA connector, magnetic mount, 2.9m</td>
</tr>
<tr>
<td>AN2020</td>
<td>Antenna, 2.4GHz, 802.11 b/g, 5 dBi, reverse polarity SMA connector, magnetic mount, 2.9m</td>
</tr>
<tr>
<td>AN2030</td>
<td>Whip antenna (stubby), dual band, 802.11 a/b/g/n, 2.4GHz 2dBi, 5GHz 3.7 dBi, reverse polarity SMA connector</td>
</tr>
<tr>
<td>20667-002</td>
<td>Whip antenna (stubby), 802.11 b/g - dipole 2 dBi reverse polarity SMA connector</td>
</tr>
<tr>
<td>AR1000</td>
<td>Right Angle SMA reverse polarity plug-jack adaptor</td>
</tr>
<tr>
<td>AN000090A01</td>
<td>GNSS antenna, magnetic mount, 2.9 m cable</td>
</tr>
</tbody>
</table>
### Table 6-1  Accessories

<table>
<thead>
<tr>
<th>Model Number</th>
<th>Accessory</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mounts</strong></td>
<td></td>
</tr>
<tr>
<td>MT4200</td>
<td>Quick release mount</td>
</tr>
<tr>
<td>MT4205</td>
<td>Mounting plate for the MT4200 quick release mount</td>
</tr>
<tr>
<td>MT4210</td>
<td>Adaptor bracket kit for 82XX quick release mount</td>
</tr>
<tr>
<td>MT4510</td>
<td>RAM rectangular base with 2.25&quot; rubber ball</td>
</tr>
<tr>
<td>MT4301</td>
<td>RAM mount, 4&quot; arm</td>
</tr>
<tr>
<td>MT4302</td>
<td>RAM mount, 12&quot; arm</td>
</tr>
<tr>
<td>MT3501</td>
<td>VESA base (for 4&quot; or 12&quot; RAM arm)</td>
</tr>
<tr>
<td>MT3502</td>
<td>Circular base (for 4&quot; or 12&quot; RAM arm)</td>
</tr>
<tr>
<td>MT3505</td>
<td>Clamp base (for 4&quot; or 12&quot; RAM arm), 2&quot; max. width</td>
</tr>
<tr>
<td>MT3507</td>
<td>Clamp base (for 4&quot; or 12&quot; RAM arm), 3&quot; max. width</td>
</tr>
<tr>
<td>MT3509</td>
<td>Rail base (for 4&quot; or 12&quot; RAM arm), 1-1/4&quot; to 1-7/8&quot;</td>
</tr>
<tr>
<td>MT3510</td>
<td>Rail base (for 4&quot; or 12&quot; RAM arm), 2&quot; to 2 1/2&quot;</td>
</tr>
<tr>
<td>KT-SCANMNT-VC80-R</td>
<td>Side mounted holder for scanner</td>
</tr>
<tr>
<td>KT-KYBDTRAY-VC80-R</td>
<td>Keyboard mounting tray (includes tilting arms, knobs and screws) for VC80 and iKey keyboards</td>
</tr>
<tr>
<td>KT-KYBDMNT-VC80-R</td>
<td>Function/Numeric keypad side mount bracket</td>
</tr>
</tbody>
</table>
### Table 6-1  Accessories

<table>
<thead>
<tr>
<th>Model Number</th>
<th>Accessory</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Keyboard</strong></td>
<td></td>
</tr>
<tr>
<td>9010376</td>
<td>iKey keyboard, 86 keys (12 Function keys), pointing device, red LED backlight, USB</td>
</tr>
<tr>
<td>9010377</td>
<td>iKey keyboard, 72 oversized color arranged keys (8 function keys), USB</td>
</tr>
<tr>
<td>SLK-101-M-USB-3F</td>
<td>iKey keyboard, 101 keys (12 function keys), large numeric pad, backlight, USB</td>
</tr>
<tr>
<td><strong>Speaker/Mic</strong></td>
<td></td>
</tr>
<tr>
<td>M1000</td>
<td>Speaker/Mic with push-to-talk function</td>
</tr>
<tr>
<td><strong>Miscellaneous</strong></td>
<td></td>
</tr>
<tr>
<td>KT-SPRTCT-VC70-05R</td>
<td>Screen protector pack of 5</td>
</tr>
<tr>
<td>SL0001</td>
<td>Stylus and stylus holder</td>
</tr>
<tr>
<td>KT-VC80-BTRY1-01</td>
<td>Spare battery</td>
</tr>
<tr>
<td>Model Number</td>
<td>Accessory</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PS000145A01</td>
<td>100/240 VAC power supply, 24 VDC, 6.5 A, 150W (AC power cord sold separately)</td>
</tr>
<tr>
<td>PS1370</td>
<td>Pre-Regulator, 24 - 90 VDC in, 15 VDC out, 90 W</td>
</tr>
<tr>
<td>CB000417A01</td>
<td>DC power adaptor to VC50</td>
</tr>
<tr>
<td>CB000416A01</td>
<td>DC Power adaptor to VC70</td>
</tr>
<tr>
<td>CA1210</td>
<td>Power extension cable, DC, 6', waterproof</td>
</tr>
<tr>
<td>CA1230</td>
<td>Power extension cable for pre-regulator</td>
</tr>
<tr>
<td>CA1220</td>
<td>Power extension cable, DC, 180 cm, with ignition sense</td>
</tr>
<tr>
<td>CA1300</td>
<td>Screen blanking cable (DB9 to open wires)</td>
</tr>
<tr>
<td>CB-000433-01</td>
<td>CAN Bus cable (RJ45 to Deutsch)</td>
</tr>
</tbody>
</table>
External Bar Code Scanners

**CAUTION** Only use Zebra approved scanners.

The VC80 supports external hand-held decoded scanners and imagers connected via USB, RS-232, or Bluetooth. See *VC80 Windows 7 Bar Code Scanners and Settings on page 3-4* to add scanner(s).

When a bar code is scanned successfully, the VC80 beeps if configured appropriately. A poorly printed or damaged bar code may not decode properly. In this case, use the keyboard to enter data from the bar code.

For more information, refer to the specific scanner manual at: [www.zebra.com/support](http://www.zebra.com/support).
VC80 Antenna Options

Antenna hardware configurations are located in Table 6-1 on page 6-1. To determine the best antenna option for your location, contact your Zebra representative.

**IMPORTANT** If using a magnetic mount antenna, place it in a location that balances the need for the VC80 to communicate with the access points and local Bluetooth peripherals.

![VC80 Antenna Options](image)

**Figure 6-1** VC80 Antenna Options
VC80 Mounting Accessories

**WARNING**  Failure to install the mount correctly, or modifications to the mount, may result in serious injury or damage to property. Contact Zebra Technical Support or your Zebra representative if you have problems installing this mount. To ensure operator safety, you must use a calibrated torque wrench and the supplied mounting hardware when fastening the computer and mount. Use of this mount in vehicles driven on public roads or highways is prohibited. Contact Zebra for further details.

Before mounting a VC80 in a vehicle, there are a number of operator safety issues that require careful attention. When mounting a VC80 use only approved Zebra mounting hardware and mounting parts which are specific to the VC80 model purchased. An improperly mounted VC80 or use of non-approved parts may result in one or more of the following: operator injury, property damage, operator visibility obstruction, operator distraction, and/or poor ease of egress for the operator. Zebra strongly recommends that you seek professional mounting advice from the vehicle manufacturer.

If it is necessary to mount the VC80 overhead, or in any position that could cause injury to the operator should the unit fall, it is critical that a secondary tether or other fail safe device be installed.

The following restrictions must be strictly enforced:

- Do not use the mount and/or the VC80 as a hand-held. Using the mount in this manner may cause the person to fall or dislodge the mounting hardware and/or mounts.
- Do not add weight or attach any other items to the mount or VC80. Additional elements may fall causing injury, or may increase the chance of failure and/or damage in mounting hardware and/or mounts.
- Mounts used in industrial or vibration generating environments may be subjected to fatigue, stress, and/or part wear. A periodic inspection of the mounting hardware and mounts should be performed to ensure parts are retightened to the correct torque, free of fractures, excessive wear, and/or other environmental damage. Any parts found to be unsafe should be removed and replaced immediately. After inspection or replacement of parts, readjust the mount as outlined in the pertinent sections below.
- Cable routing within a vehicle cab also requires careful consideration, especially for separately connected scanners and other devices with loose cables. If you are unable to obtain suitable advice, contact Zebra for assistance. For better protection, the equipment should be mounted inside the vehicle roll cage.
- When charging the vehicle battery, the VC80 must be either disconnected from the battery or it must be determined that the maximum allowed input voltage of the VC80 is not exceeded.
MT43XX RAM Mount

**IMPORTANT** To avoid injury, this device must be properly secured when in a moving vehicle.

- Keep this device away from magnetic fields.
- Do not place the computer near a television or radio receiver.
- Do not disassemble the VC80 computer as there are no user-serviceable parts inside.

**IMPORTANT** The operator can easily adjust the tilt and rotation of the VC80. Use care to avoid operator injury or equipment damage if the computer slips due to a loosened hand screw.

The VC80 may be installed using an articulating RAM Mount (Model MT43XX – 4 in. or 12 in. arm) secured to either a VESA or circular base.

The RAM articulating mount can be installed in a variety of orientations (see Figure 6-3 on page 6-9). Select the best orientation for the specific application. Preferred orientations maintain the center of mass of the computer assembly, directly over the center of the base.

For detailed mount installation information, refer to the instructions included with the mount kit.

![Figure 6-2 Orientation of Vehicle-Mount Assembly](image)
Optional Mounts

One of the following optional mounting kits shown in Figure 6-3 may be substituted for the Vesa base or the circular base when mounting to a post or forklift roll cage.

To assemble the optional mount kit:

1. Mount the clamp base and lower base around the shaft.
2. Place the screw through the clamp and the lower base, and affix with the nut.
3. Torque to 26 in-lbs.
4. Secure the RAM standard arm by inserting the RAM balls into both ends of the arm sockets.

![Optional Mount Kits](image)

Plate Bases for MT35XX Mounts

Plate bases are not recommended for forklift mounting solutions. If this requires a plate rather than a clamp base, you must penetrate into the structure of the vehicle. This requires additional hardware. The following plate bases are available:

- MT3501 - VESA Plate
- MT3502 - Circular Plate
MT4200 Quick Release Mount

The MT4200 Quick Release Mount allows a removal without the need for tools.

Assembling MT4200

To assemble the MT4200 Quick Release mount:

1. Place the back mounting plate hooks into the base plate slots.
2. Snap spring clips into place.

Figure 6-4 MT4200 Quick Release Mount Assembly
Attaching MT4200 to VC80

To attach the MT4200 Quick Release Mount to the VC80:

1. Line up the MT4200 mounting bracket holes with the holes on the sides of the VC80 (two on each side).
2. Place the washer spring lock onto the hex head screw.
3. Place the washer flat onto the hex head screw (on top of the washer spring lock).
4. Screw the bracket onto the VC80 (total of four). Torque to 34.7 in-lbs.

Figure 6-5  VC80 and MT4200 Assembly
The MT4210 Adaptor Bracket is for use with older mounts, such as the 82XX Quick Release Mount.

To assemble the MT4210 Adaptor Bracket:

1. Line up the MT4210 mounting bracket holes with the holes on the sides of the VC80 (two on each side).
2. Place the washer spring lock onto the hex head screw.
3. Place the washer flat onto the hex head screw (on top of the washer spring lock).
4. Screw the metal adaptor bracket onto the VC80 (total of four). Torque to 34.7 in-lbs.

Figure 6-6  MT4210 Adaptor Bracket Assembly
CHAPTER 7 SCANCODE MAP

Introduction

This chapter provides information on the integrated bezel scancode map for the VC80.
Integrated Keypad

The VC80 has six integrated programmable keys located below the display. Each programmable key can be modified by the Blue key for a total fourteen keys.

Figure 7-1  VC80 Front Keys and LED Indicators

To change scancodes to assign unique functions/characters, edit the scancodes.txt file in c:\VC.

Figure 7-2  Scancode Map

<table>
<thead>
<tr>
<th>101 Keyboard</th>
<th>Scan 2 Make</th>
</tr>
</thead>
<tbody>
<tr>
<td>~</td>
<td>0E</td>
</tr>
<tr>
<td>!</td>
<td>16</td>
</tr>
<tr>
<td>@</td>
<td>1E</td>
</tr>
<tr>
<td>#</td>
<td>26</td>
</tr>
<tr>
<td>$</td>
<td>25</td>
</tr>
<tr>
<td>%</td>
<td>2E</td>
</tr>
<tr>
<td>^</td>
<td>36</td>
</tr>
<tr>
<td>&amp;</td>
<td>3D</td>
</tr>
<tr>
<td>*</td>
<td>3E</td>
</tr>
<tr>
<td>(</td>
<td>46</td>
</tr>
<tr>
<td>)</td>
<td>45</td>
</tr>
<tr>
<td>_</td>
<td>4E</td>
</tr>
<tr>
<td>+</td>
<td>55</td>
</tr>
<tr>
<td>Backspace</td>
<td>66</td>
</tr>
<tr>
<td>Tab</td>
<td>0D</td>
</tr>
<tr>
<td>Q</td>
<td>15</td>
</tr>
<tr>
<td>W</td>
<td>1D</td>
</tr>
<tr>
<td>E</td>
<td>24</td>
</tr>
<tr>
<td>R</td>
<td>2D</td>
</tr>
<tr>
<td>T</td>
<td>2C</td>
</tr>
<tr>
<td>Y</td>
<td>35</td>
</tr>
<tr>
<td>U</td>
<td>3C</td>
</tr>
<tr>
<td>I</td>
<td>43</td>
</tr>
<tr>
<td>O</td>
<td>44</td>
</tr>
<tr>
<td>P</td>
<td>4D</td>
</tr>
<tr>
<td>101 Keyboard</td>
<td>Scan 2 Make</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>{ [</td>
<td>54</td>
</tr>
<tr>
<td>} ]</td>
<td>5B</td>
</tr>
<tr>
<td>\</td>
<td>5D</td>
</tr>
<tr>
<td>Caps Lock</td>
<td>58</td>
</tr>
<tr>
<td>A</td>
<td>1C</td>
</tr>
<tr>
<td>S</td>
<td>1B</td>
</tr>
<tr>
<td>D</td>
<td>23</td>
</tr>
<tr>
<td>F</td>
<td>2B</td>
</tr>
<tr>
<td>G</td>
<td>34</td>
</tr>
<tr>
<td>H</td>
<td>33</td>
</tr>
<tr>
<td>J</td>
<td>3B</td>
</tr>
<tr>
<td>K</td>
<td>42</td>
</tr>
<tr>
<td>L</td>
<td>4B</td>
</tr>
<tr>
<td>; ;</td>
<td>4C</td>
</tr>
<tr>
<td>''</td>
<td>52</td>
</tr>
<tr>
<td></td>
<td>5D</td>
</tr>
<tr>
<td>Enter</td>
<td>5A</td>
</tr>
<tr>
<td>L Shift</td>
<td>12</td>
</tr>
<tr>
<td>Z</td>
<td>1A</td>
</tr>
<tr>
<td>X</td>
<td>22</td>
</tr>
<tr>
<td>C</td>
<td>21</td>
</tr>
<tr>
<td>V</td>
<td>2A</td>
</tr>
<tr>
<td>B</td>
<td>32</td>
</tr>
<tr>
<td>N</td>
<td>31</td>
</tr>
<tr>
<td>M</td>
<td>3A</td>
</tr>
<tr>
<td>&lt; ,</td>
<td>41</td>
</tr>
<tr>
<td>&gt; .</td>
<td>49</td>
</tr>
<tr>
<td>? /</td>
<td>4A</td>
</tr>
<tr>
<td></td>
<td>51</td>
</tr>
<tr>
<td>R SHIFT</td>
<td>59</td>
</tr>
<tr>
<td>L CTRL</td>
<td>14</td>
</tr>
<tr>
<td>L ALT</td>
<td>11</td>
</tr>
<tr>
<td>Space Bar</td>
<td>29</td>
</tr>
<tr>
<td>101 Keyboard</td>
<td>Scan 2 Make</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>R ALT</td>
<td>E0 11</td>
</tr>
<tr>
<td>R CTRL</td>
<td>E0 14</td>
</tr>
<tr>
<td>Num Lock</td>
<td>77</td>
</tr>
<tr>
<td>Numeric 7</td>
<td>6C</td>
</tr>
<tr>
<td>Numeric 4</td>
<td>6B</td>
</tr>
<tr>
<td>Numeric 1</td>
<td>69</td>
</tr>
<tr>
<td>Numeric 8</td>
<td>75</td>
</tr>
<tr>
<td>Numeric 5</td>
<td>73</td>
</tr>
<tr>
<td>Numeric 2</td>
<td>72</td>
</tr>
<tr>
<td>Numeric 0</td>
<td>70</td>
</tr>
<tr>
<td>Numeric *</td>
<td>7C</td>
</tr>
<tr>
<td>Numeric 9</td>
<td>7D</td>
</tr>
<tr>
<td>Numeric 6</td>
<td>74</td>
</tr>
<tr>
<td>Numeric 3</td>
<td>7A</td>
</tr>
<tr>
<td>Numeric .</td>
<td>71</td>
</tr>
<tr>
<td>Numeric -</td>
<td>7B</td>
</tr>
<tr>
<td>Numeric +</td>
<td>79</td>
</tr>
<tr>
<td>Numeric Enter</td>
<td>E0 5A</td>
</tr>
<tr>
<td>Esc</td>
<td>76</td>
</tr>
<tr>
<td>F1</td>
<td>5</td>
</tr>
<tr>
<td>F2</td>
<td>6</td>
</tr>
<tr>
<td>F3</td>
<td>4</td>
</tr>
<tr>
<td>F4</td>
<td>0C</td>
</tr>
<tr>
<td>F5</td>
<td>3</td>
</tr>
<tr>
<td>F6</td>
<td>0B</td>
</tr>
<tr>
<td>F7</td>
<td>83</td>
</tr>
<tr>
<td>F8</td>
<td>0A</td>
</tr>
<tr>
<td>F9</td>
<td>1</td>
</tr>
<tr>
<td>F10</td>
<td>9</td>
</tr>
<tr>
<td>F11</td>
<td>78</td>
</tr>
<tr>
<td>F12</td>
<td>7</td>
</tr>
<tr>
<td>Scroll Lock</td>
<td>7E</td>
</tr>
</tbody>
</table>
APPENDIX A SPECIFICATIONS

Introduction

The following tables summarize the device’s intended operating environment and technical specifications.
## Technical Specifications

**Table A-1  Technical Specifications**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Physical and Environmental Characteristics</strong></td>
<td></td>
</tr>
<tr>
<td>Dimensions</td>
<td>10.83 in. L x 9.35 in. W x 3.46 in. D</td>
</tr>
<tr>
<td></td>
<td>275.2 mm L x 237.4 mm W x 88 mm D</td>
</tr>
<tr>
<td>Weight</td>
<td>8.6 lbs/3.9 kg</td>
</tr>
<tr>
<td>Display:</td>
<td>10.4 in. color XGA</td>
</tr>
<tr>
<td>Size</td>
<td>1024 x 768 LCD with LED backlight; 24 bit color depth</td>
</tr>
<tr>
<td>Resolution</td>
<td>400 NITs or 1000 NITs</td>
</tr>
<tr>
<td>UPS and Backup Battery</td>
<td>Rechargeable UPS battery for operation during power loss; Internal rechargeable battery for multiple months of real-time clock backup</td>
</tr>
<tr>
<td>IP Sealing</td>
<td>IP 66</td>
</tr>
<tr>
<td>Interface Ports</td>
<td>Standard sealed and secured connectors:</td>
</tr>
<tr>
<td></td>
<td>• Two RS-232 serial port</td>
</tr>
<tr>
<td></td>
<td>• One standard USB port</td>
</tr>
<tr>
<td></td>
<td>• One powered USB port</td>
</tr>
<tr>
<td></td>
<td>• One 3.5 mm audio jack</td>
</tr>
<tr>
<td></td>
<td>• Optional ethernet (10/100/1000 Mbps) or isolated CAN bus port with SAE J1929 support</td>
</tr>
<tr>
<td>Thermal Shock</td>
<td>-22° to 122° F/-30° to 50° C</td>
</tr>
<tr>
<td><strong>User Environment</strong></td>
<td></td>
</tr>
<tr>
<td>Operating Temperature</td>
<td>-22° to 122° F/-30° to 50° C</td>
</tr>
<tr>
<td>Storage Temperature</td>
<td>-22° to 140° F/-30° to 60° C</td>
</tr>
<tr>
<td>Relative Humidity</td>
<td>5% to 95% non-condensing (standard version)</td>
</tr>
<tr>
<td></td>
<td>5% to 95% condensing (freezer version with internal heating)</td>
</tr>
<tr>
<td>Salt Fog</td>
<td>48 hours of 5% solution at 35° C</td>
</tr>
<tr>
<td>Solar Radiation</td>
<td>MIL STD 810-G, Method 505.5, Procedure I</td>
</tr>
<tr>
<td>ESD</td>
<td>+/-15kV air discharge</td>
</tr>
<tr>
<td></td>
<td>+/-8kV direct discharge</td>
</tr>
</tbody>
</table>
Integrated Sensors
Motion (accelerometer); temperature; ignition

Shock/Vibration
IEC 60721-3-5M3; MIL-STD 810G; Method 514.6; MIL-STD 810G; Method 516.6

Power Consumption
- 16W: Display brightness at 1/2, keyboard backlight off, radio in received mode, UPS battery fully charged.
- 38W: Full display brightness, full external keyboard backlight on, radio running ping test, UPS battery is charging, scanner connected.
- 84W: Full display brightness, full external keyboard backlight on, radio running ping test, UPS battery is charging, scanner connected, touch screen heater on.

Performance Characteristics
CPU/RAM
Intel E3825 Dual Core, 1.33 GHz with 2GB RAM or Intel E3845 Quad Core, 1.91 GHz with 4GB RAM

Operating System
- Windows Embedded Standard 7, 64 bit; Windows 7 Professional, 64 bit
- Windows 10 IoT Enterprise 2016 LTSB Entry

Internal Expansion
Two PCIe mini slots (one standard, one optional); one M.2 slot

Mass Storage
mSATA SSD: 32 or 64 GB

Additional Software
My-T-Soft configurable on-screen keyboard; Scanner Wedge with code manipulations; Tekterm

Application Development
Standard Windows plus WMI additions

Touchscreen
- Resistive touchscreen with passive stylus or finger operation
- Freezer version includes integrated touchscreen heater for evaporates external condensation.
- Construction: Film-Glass (FG)
- Hardness of surface: 3H (ASTM D3363)
- Resistance: 35 million actuations

Audio
High volume 87 dBA speaker (at 1 foot distance)

Push-to-Talk
External optional speaker/microphone

WLAN Wireless Data Communications
WLAN radio
IEEE 802.11a/b/g/n/ac 2x2 MIMO
### Technical Specifications (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Power</td>
<td>2.4GHz=+17.5dBm max, 5GHz=+17.5dBm max</td>
</tr>
<tr>
<td>Data Rate</td>
<td>867Mbps @ 5GHz, 300Mbps @ 2.5GHz</td>
</tr>
<tr>
<td>Frequency Range</td>
<td>Country dependent&lt;br&gt;2.4GHz band (802.11b/g/n) = 2400-2483.5MHz&lt;br&gt;5GHz band (802.11a/n/ac) = 5150-5350MHz, 5470-5855MHz.</td>
</tr>
<tr>
<td>Antenna</td>
<td>Internal or external</td>
</tr>
<tr>
<td>WLAN Security</td>
<td>WPA, WPA2, AES, TKIP, WEP, 802.11x, CCX v4</td>
</tr>
<tr>
<td>WPAN Wireless Data Communications</td>
<td>Bluetooth V2.1 + EDR (Window7/10)&lt;br&gt;Bluetooth V4.0 Smart Ready (Windows 10)</td>
</tr>
<tr>
<td>GPS</td>
<td>Optional with DGPS support</td>
</tr>
<tr>
<td>Power Supply</td>
<td>Internal power supply 12-48V nominal</td>
</tr>
</tbody>
</table>
VC80 Drill Hole Dimensions

Figure A-1 VC80 Drill Hole Dimensions
### INDEX

**B**
- bar code scanners .......................................................... 3-4, 4-4
  - bluetooth scanners .......................................................... 3-6, 4-6
  - pairing bluetooth scanners ............................................. 3-6, 4-6
  - serial scanners .............................................................. 3-4, 4-4
  - USB scanners ................................................................. 3-6, 4-6
- broadcom help ................................................................. 1-10, 1-13

**C**
- cable dust cover ............................................................ 2-5
- cables, installing in vehicle .............................................. 2-3
- cleaning
  - housing ........................................................................... 5-1
- connections
  - external devices ............................................................ 1-7
- conventions
  - notational ........................................................................ xi
- CPU .................................................................................. A-3

**D**
- dimensions ........................................................................ A-2
- display ............................................................................... A-2

**E**
- electrical installation ......................................................... 2-2
- emergency shutdown ......................................................... 1-2
- external devices
  - connect external devices .................................................. 1-7

**F**
- Forklift ............................................................................... 2-7
- forklift battery replacement ................................................. 2-7
- forklift installation ............................................................... 2-2
- front keys .......................................................................... 1-5

**G**
- GPS
  - configure GPS ................................................................ 1-6
- ground bolt ........................................................................ 2-2

**H**
- Heater Status .................................................................... 2-1

**I**
- information, service .......................................................... xii
- installation
  - non-vehicle ..................................................................... 2-8
  - vehicle ............................................................................. 2-8

**K**
- keyboard ............................................................................. 6-1
- kiosk
  - configuration .................................................................. 3-33, 4-34
  - additional software ......................................................... 3-35, 4-36
  - complete setup .................................................................. 3-35, 4-36
  - exit kiosk mode ................................................................ 3-35, 4-36
  - launch apps with UAC prompt ........................................ 3-36, 4-37
  - lockdown ........................................................................... 3-34, 4-35
  - monitor utility ................................................................... 3-34, 4-35
  - security .............................................................................. 3-34, 4-35
  - shell settings .................................................................... 3-33, 4-34

**L**
- LAN .................................................................................... 1-8
LED indicators .............................. 1-5
LEDs ........................................ 7-2

**M**

Microsoft setup and configuration ........... 3-1, 4-1
mounting
  assembly steps ................................ 2-5
  instructions .................................. 2-1
MT43XX RAM Mount kit .......................... 6-8

**O**

operating
  emergency .................................... 1-2
  operating system .............................. A-3
  VC80 without OS .............................. 3-2, 4-2
 optional mount kits ........................... 6-9

**P**

power
  power down VC80 ............................. 1-7
  power up VC80 ................................ 1-7
  supply ...................................... 1-2
  protection .................................. 1-2
  safety ...................................... 1-2

**R**

RAM Mount kit ................................ 6-8
related documents ............................. xii

**S**

scanners ...................................... 6-5
screen blanking ............................... 3-22, 4-23
settings ...................................... 3-9, 4-9
software components .......................... 3-2, 4-2
specifications ................................. ii-xi, A-1
strain relief rail .............................. 2-5

**T**

technical specifications ...................... A-2
terminal emulation ............................ 3-3, 4-3
tekterm ...................................... 3-3, 4-3
touchscreen .................................... 5-2
cleaning ...................................... 3-1, 3-9, 4-1, 4-9, 5-1, 7-1
operation ..................................... 3-1, 3-9, 4-1, 4-9, 5-2, 7-1
software ...................................... 3-1, 4-1, 7-1
specifications ................................ 5-2
troubleshooting ............................... 5-3

**U**

unpacking ..................................... 1-1

**V**

VC80
  features ...................................... 1-3
  vehicle
    battery, charging ........................... 1-2
  vehicle-mount installation
    cables ...................................... 2-3
  VESA drill holes .............................. A-5

**W**

weight ........................................ A-2
WiFiReconnectService ......................... 1-14
  configuration ................................ 1-14
  event viewer ................................ 1-15
  start/stop service ........................... 1-15
WLAN ........................................... 1-8
  connecting WLAN .............................. 1-8, 1-11
  set up new connection ....................... 1-9, 1-12